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Introduction
This book includes descriptions and procedures for using Siebel Sales and is useful 
to individuals whose titles or job descriptions are similar to the following positions.

Sales 
Professionals

Persons who use Siebel Sales to manage sales leads, opportunities, 
accounts, quotes, and so on.

Database 
Administrators

Persons who administer the database system, including data 
loading, system monitoring, backup and recovery, space 
allocation and sizing, and user account management.

Siebel Application 
Administrators

Persons responsible for planning, setting up, and maintaining 
Siebel applications.

Siebel Application 
Developers 

Persons who plan, implement, and configure Siebel applications, 
possibly adding new functionality.

Siebel System 
Administrators

Persons responsible for the whole system, including installing, 
maintaining, and upgrading Siebel applications. 
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How This Guide Is Organized
How This Guide Is Organized
This guide includes general information and procedures for Siebel Sales end users. 
Information included in this guide can also help administrators and application 
developers who need to understand the Siebel Sales application to customize it.

Chapters are organized according to a typical sales methodology process flow:

■ Prospecting. These chapters include procedures for managing contacts, 
accounts, opportunities, and Dun & Bradstreet integration.

■ Qualification. These chapters include procedures for managing competitors and 
products.

■ Managing a Customer Relationship. These chapters include procedures for 
managing activities, correspondence, literature, categories, and messages, a 
separately licensed product.

■ Proposing a Solution. This chapter includes information on quotes and orders.

■ Closing. These chapters include information on Target Account Selling and 
Strategic Selling� sales methodologies.

NOTE: All Siebel MidMarket product names include the phrase MidMarket Edition 
to distinguish this product from other Siebel eBusiness Applications. However, in 
the interest of brevity, after the first mention of a MidMarket product in this 
document, the product name is given in abbreviated form. For example, after Siebel 
Call Center, MidMarket Edition, has been mentioned once, it is referred to simply 
as Siebel Call Center. Such reference to a product using an abbreviated form should 
be understood as a specific reference to the associated Siebel MidMarket Edition 
product, and not any other Siebel Systems offering. When you contact Siebel 
Systems for technical support, sales, or other issues, furnish the full name of the 
product to verify its proper identification and handling.
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Additional Resources
Additional Resources 
The following Siebel application guides contain information relevant to your use of 
Siebel Sales:

■ For information on administrative procedures and tasks, see Applications 
Administration Guide, MidMarket Edition.

■ For information on campaigns, see Siebel Call Center User Guide, MidMarket 
Edition. 

■ For information on list management, see Siebel Campaigns Guide, MidMarket 
Edition. 

■ For information on SmartScripts, see Siebel SmartScript Administration Guide, 
MidMarket Edition.

■ For information on forecasting, see Siebel Forecasting Guide, MidMarket Edition.

■ For development resources and information, see Siebel Tools Reference, 
MidMarket Edition and Siebel Tools Online Help, MidMarket Edition.

Revision History
Siebel Sales User Guide,  MidMarket Edition, Version 7.5.
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Overview 1
This chapter explains how a typical sales organization is structured, the sales 
workflow process, and a typical sales organization’s goals and strategies.
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Overview

The Sales Organization
The Sales Organization
The primary purpose of a sales organization is to increase revenues while 
maximizing profits. The sales process varies by organization. However, certain 
similarities do exist. Siebel Sales allows each organization to adapt its usage to 
current business needs, while building on similarities in practices found across 
many sales organizations.

Siebel Sales assists sales professionals throughout the entire sales cycle with tools 
and information that help the sales team manage opportunities, the sales pipeline, 
customer profiles, accounts, products, pricing, competitors, and sales brochures 
and data sheets.
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Sales Strategy
Sales Strategy
The workflow shown in Figure 1 describes the sales process. Sales strategy and 
prospecting begin the pipeline process, followed by leads qualification, 
opportunities management, customer proposals, and closing the deals.

Siebel Sales provides the sales professional with a view of each customer interaction 
across multiple channels including the Web, call center, and partner organizations. 
Using Siebel Sales, the sales team has the account, contact, and history information 
it needs to make better decisions. 

Siebel Sales offers tools for each sales task. The tools include the following:

■ Contacts and Accounts management

■ Opportunities

■ Quotes

■ Correspondence and Literature

■ Activities

■ D&B

■ Target Account Selling and Strategic Selling

Figure 1. Sales Process Workflow
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Sales Goals and Strategies
Sales Goals and Strategies
Table 1 shows a typical sales organization’s goals and corresponding strategies. An 
example of a goal is maximize profits. The corresponding strategy is instituting 
uniform sales methods and practices.

Table 1. Typical Sales Organization Goals and Strategies

Goal Strategy

Sell products and services Generate new sales opportunities

Shorten sales cycle Deliver a well-trained sales force

Maximize profits Institute uniform sales methods and practices

Maximize customer satisfaction Build and maintain relationships with existing 
customers
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Contacts 2
This chapter explains how sales professionals can use the Contacts screen to record 
information about individuals who interact with their company.
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Contacts Overview
Contacts Overview
Contacts are individuals with whom your company conducts business or expects to 
conduct business in the future. Contacts can be employees of other companies, 
independent consultants, vendors, or personal acquaintances. Contacts can be 
associated with several accounts, but a contact is the primary on only one account. 
Contacts, including those contacts that are not related to accounts, can also be 
associated with a number of opportunities.

Business Scenario
In the course of a business day, sales representatives interact with other 
professionals. These formal and informal exchanges can result in potential leads or 
sales opportunities. 

Using Siebel Sales, the sales representative can determine if her company has done 
business with this particular company by reviewing account and contact records. 
The sales representative can also create new contact records in the Siebel Sales 
application, and associate the contacts with new or existing accounts.

If the possibility of doing business—an opportunity—arises, the sales representative 
can create the opportunity and associate activities and contacts with the 
opportunity. This helps the sales representative track important milestones for 
obtaining and closing deals.
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Contacts Views and Procedures
When you identify an individual who is a possible source for leads, you can add 
that individual’s information to your Siebel application as a contact. You and your 
team members can access the contact information when you are working on 
potential business opportunities. 

A contact team is a group of employees or partners who can view the contact 
information in the My Contacts view. If you work in a Mobile Web Client 
environment and are a member of the contact team, the contact information is 
downloaded to your local database the next time you synchronize.

You access different Contacts screen views to perform the following tasks:

■ View your own contacts, with information that can include accounts, activities, 
and opportunities

■ Enter information about your contacts, and track your relationships using the 
My Contacts list

■ Search and query using criteria you define to identify contacts associated with 
accounts or opportunities which you are pursuing

Adding a Contact

To add a contact

1 Navigate to the Contacts screen.

A contact record only appears on the My Contacts view if you are on the contact 
team for the contact.

2 From the Show drop-down list, select All Contacts.
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3 In the Contacts list, click New, and complete the necessary fields.

If the name includes unsupported characters such as an apostrophe (‘), an error 
message appears.

Click the show more button to display additional fields in the More Info form.

The following table describes fields in the Contact form.

Field Comments

Account Displays the account with which the contact is 
associated.

Address Line 1 Displays the primary address for the associated account.

Comments A text field that shows any additional information 
associated with the contact.

Contact Method A list of values established by your company that is used 
to define the contact’s preferred method of interaction. 
Default values include Email, Fax, Pager, and Phone.

Contact Team A default value based on your user ID. After you create a 
contact, you are automatically listed as the primary team 
member. You can add individuals to the contact team by 
selecting them from the employee list. Only a manager or 
administrator can change the primary contact team 
member, or can delete the primary contact team member.

Disable Cleansing A check box which, when selected, does not allow data 
cleansing.

Employee Flag If checked, this flag indicates that the contact is an 
employee of your company.

First Name A required field that displays the contact’s first name.

Global Owner Displays the name of the team member who is the global 
account owner. In cases of multinational or global 
companies, this designates one main account team 
member to oversee the account.

Job Title A text field that displays the contact’s professional title.

Last Name A required field that displays the contact’s last name.
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Lock Assignment A check box which, when selected, locks the contact 
team assignment from reassignment by Siebel Territory 
Assignment Manager, MidMarket Edition.

Manager Last Name Displays the manager’s last name. This field must be 
populated before you can perform an organizational 
analysis. For more information, see Chapter 4, 
“Opportunities.”

Middle Initial An optional field that displays the contact’s middle initial.

Never Call A check box which, when selected, indicates that the 
contact should not be telephoned as a method of contact.

Never Email A check box which, when selected, indicates the contact 
does not want to receive email.

Never Mail A check box which, when selected, indicates that the 
contact does not want to receive mail from your company.

Organization A default value displaying the name of the organization 
to which you belong. Your system administrator sets up 
organizations in your Siebel application. You can 
associate multiple organizations with an opportunity, but 
your organization is listed as the default organization.

Send Email Updates A check box which, when selected, indicates that the 
contact is willing to receive email updates about products 
and services.

Status Examples are Active, Qualified, Marked for Deletion.

Sync A read-only check box, which indicates the user has 
included the contact record in the user’s Sync List. 
Requires Siebel Sync.

Sync List A dialog box that displays the User IDs of users who 
synchronize the contact with a personal information 
manager (PIM) such as Lotus Notes or Microsoft Outlook. 
Requires Siebel Sync.

Time Zone Displays the time zone in which the contact works or 
lives.

Field Comments
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Associating a Contact with an Account
A contact can be associated with one or more accounts, although the contact is 
designated as the primary on only one account. Use the Accounts view to list 
accounts associated with a contact.

To associate a contact with an account

1 Navigate to the Contacts screen.

2 In the Contacts list, select the contact, and then click the Accounts view tab.

3 In the Accounts list, click New.

4 In the Add Accounts dialog box, select the account associated with the contact, 
and then click OK.

In the Add Accounts dialog box, click New to add a new account.

Associating a Contact with an Opportunity
A contact can be a source of revenue for your company. Potential revenue-
generating events are called opportunities. You associate a contact with an 
opportunity to track information about both the opportunity and the contact.

To associate a contact with an opportunity

1 Navigate to the Contacts screen.

2 In the Contacts list, select the contact, and then click the Opportunities view tab.

3 In the Opportunities list, click New.

4 In the Add Opportunities dialog box, select the opportunity to associate with the 
contact, and then click OK.
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Associating Attachments with a Contact
An attachment is a file created in another application that you can associate with a 
contact record. You attach documents to contact records to maintain an interaction 
history for the contact or the opportunity. Attachments can include email 
correspondence, pending contracts, and product data sheets. Associating 
attachments with a contact record allows the sales team to share information about 
the contact.

To associate an attachment with a contact

1 Navigate to the Contacts screen.

2 In the Contacts list, select the contact, and then click the Attachments view tab.

3 In the Attachments list, click New.

The Update File check box is automatically selected as a default. If you do not 
want the attached file automatically updated as the source file changes, clear the 
check box.

4 In the Attachment Name field, click the select button.

5 In the Add Attachment dialog box, click Browse.

6 In the Choose File dialog box, select the file, and then click Open.

7 In the Add Attachment dialog box, click Add.

The attachment appears in the Attachments list.
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Promoting a Contact
Contact records can be promoted from the My Personal Contacts view to the My 
Contacts view.

To promote a contact from My Personal Contacts to the My Contacts

1 Navigate to the Contacts screen.

2 From the Show drop-down list, choose My Personal Contacts.

3 In the Contacts list, select the contact for promotion.

4 In the Contact form, click the show more button to display additional fields.

5 In the Contact form, clear the check box in the Private field.

The Contact record appears in the My Contacts list.

NOTE: You cannot designate a contact as Private (My Personal Contacts) from the 
My Contacts list.

Creating a Profile for a Contact
A profile consists of information that you collect about a contact. This information 
can include a contact’s expenditure approval, hobbies, education, and the name of 
the contact’s spouse.

To create a profile

1 Navigate to the Contacts screen.

2 In the Contacts list, select the contact, and then click the Profile view tab.

3 In the Profile form, complete the fields.
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Adding a Contact to a Sync List
A contact can be added to a list for synchronization with a personal information 
manager (PIMs) such as Microsoft Outlook, using Siebel Sync. For more information 
about synchronizing contacts, see Siebel Sync Guide, MidMarket Edition.

To add a contact to a sync list

1 Navigate to the Contacts screen.

2 In the Contacts list, select the contact to be added to the Sync List.

3 Click the menu button, and then select Add to Sync List.

A check mark appears in the Sync check box in the Contact form.

A contact can also be added to a different Sync List by clicking the select button 
in the Sync List field in the contact form.

To remove a contact from a sync list

1 Navigate to the Contacts screen.

2 In the Contacts list, select the contact to be removed from the Sync List.

3 Click the menu button, and then select Remove from Sync List.

The check mark is removed from the Sync check box in the Contact form.
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Updating Contact Information in External Systems
If your Siebel administrator has set up real-time integration of contacts between 
Siebel Sales and a back-office system or other systems in your organization, you can 
use the Update External System command to send new and modified contact 
information from Siebel Sales to another system.

This Application Services Interface (ASI) feature allows you to initiate a real-time 
contact data update between Siebel and external system, maintaining consistent 
customer information across the enterprise and eliminating manual entry of 
customer data in multiple systems.

The Update External Systems command can also be used to synchronize account 
data with external systems. For more information, see “Updating Account 
Information in External Systems” on page 38.

This procedure assumes that your Siebel administrator has completed the work 
necessary to allow real-time contact integration through ASI. For information about 
how to set up the Web services administration to communicate with the external 
system, ASI structures, configuring and customizing the ASI, see Application 
Services Interface Reference: Siebel eBusiness Application Integration Volume VI, 
MidMarket Edition and Applications Administration Guide, MidMarket Edition.

To update contact information in an external system

1 Navigate to the Contacts screen.

2 In the Contacts list, click New.

3 In the new contact record, complete the fields.

4 (Optional) Click the Accounts view tab.

5 (Optional) In the Accounts list, click New, and then complete the fields to 
associate an account with the contact.

6 In the Contacts list click the menu button, and then choose Update External 
System.
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This chapter explains how sales professionals can use the Accounts screen to create 
new customer accounts, modify and add account information for existing 
customers, respond to customer inquiries, and view account information.
Version 7.5 Siebel Sales User Guide MidMarket Edition 29



Accounts

Accounts Overview
Accounts Overview
An account represents the relationship between your company and the companies 
or individuals with whom you conduct business. You use the Accounts screen and 
its associated views as the primary navigation tool for customer interactions.

Business Scenario
At a vendor site, a sales representative meets a prospect. After a brief discussion, 
the sales representative determines that the prospect is interested in learning more 
about the products and services that the sales representative’s company sells. The 
sales representative sets up a sales call with the prospect later in the week.

During the sales call, the sales representative asks a number of questions to 
determine the account structure of the prospect’s business and to decide how best 
to meet the prospect’s needs.

The sales representative learns that the prospect’s business has four locations, and 
that each service is billed through the main office, and each location receives a 
billing statement. 

After the meeting, the sales representative returns to the office and begins creating 
the account structure for the prospect’s business.
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When you identify a possible lead, the lead can be added to your Siebel application 
as an account. You can then begin to add and track information about the account.

You can access different Accounts screen views to perform the following tasks:

■ View your own accounts, with information that can include contacts, activities, 
profile, and opportunities

■ Enter information about your accounts and track your relationships through the 
My Team’s Accounts list

■ Search and query on criteria you define to help identify accounts that are 
potential opportunities

Creating an Account
After you have identified a business relationship, you can enter the details about 
the account in your Siebel application. As you gain additional information, or as 
account details evolve or change, you can update the account information. Before 
adding a new account, search the accounts list to make sure the account does not 
already exist.

To create an account

1 Navigate to the Accounts screen.

2 In the Accounts list, click New, and then complete the fields for the new account.

3 In the Account More Info form, click the show more button and complete 
additional fields as needed.

The following table describes fields in the Account form.

Field Comments

Account Type A list of values established by your company defines the 
type of account. Default values include Commercial, 
Competitor, Consultant, and Customer.

Assignment Area Code Displays an area code for the account. This indicates 
that a sales representative from the same area code 
should be assigned to the account.
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Assignment Country Code Displays a country code for the account. This indicates 
that a sales representative from the same country code 
should be assigned to the account.

PO Auto-Approval Limit The amount for which a Purchase Order can be 
automatically approved.

Competitor A check box which, when selected, indicates the 
account is a competitor.

Current Volume Displays a monetary amount that represents the 
account’s current sales volume.

Disable Cleansing A check box which, when selected, does not allow data 
cleansing.

Domestic Ultimate DUNS Displays the DUNS number for the domestic ultimate, 
which is the highest member in the hierarchy for the 
same business entity within the same country. A case 
can be its own domestic ultimate.

DUNS# The Data Universal Numbering System (DUNS) 
numeric serial number for a company. The DUNS 
number is unique for each company.

Expertise A list of values established by your company that 
defines the area of expertise for the account. Default 
values include Technology, Quality Control, and Client 
Management.

Global Owner Displays the ID of the team member who is the global 
account owner. In cases of multi-national or global 
companies, this designates one main account team 
member to oversee the account.

Global Ultimate DUNS Displays the DUNS number for the global ultimate, 
which is the highest member in the hierarchy for the 
same business entity worldwide.

Inventory Location Displays the physical location of the inventory.

Lock Assignment A check box which, when selected, locks the sales team 
assignment from reassignment by Siebel Territory 
Assignment Manager.

Name A required value that identifies the account.

Organization Displays the name of the organization with which the 
account is associated in your Siebel application.

Field Comments
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NOTE: When a company change names or merges with another company, you must 
transfer account names and contacts to the new account name. Contact Siebel 
Technical Support or your implementation team for more information on how to 
rename an account.

Parent Displays a parent account if the account is a subsidiary 
of a larger company.

Parent/HQ DUNS D&B number for the account's parent account.

Partner A check box which, when selected, indicates the 
account is a business partner.

PO Approval Limit Displays a monetary limit up to which a PO is approved.

PO Approved A check box which, when selected, indicates the 
Purchase Order (PO) has been approved.

Potential Volume Displays a monetary amount that represents the 
account’s potential sales volume.

Price List Displays a price list associated with the account. Your 
application administrator establishes price lists based 
on criteria defined by your company.

Shipping Information A text field for additional shipping details.

Shipping Terms A list of values established by your company that 
defines the terms for shipping. Default values include 
Due, FOB, TBD, and No Charge. 

Stage A list of values established by your company that 
defines the account stage according to your sales or 
other methodology. Default values include Project 
Planning and Strategy, Analysis and Design, Testing and 
Production Pilot, Rollout, and On Hold.

Status A list of values established by your company that 
defines the account status. Default values include 
Active, Contract Pending, Gold, and Inactive.

Synonyms Displays a synonym for the account.

URL Displays the Universal Resource Locator (URL) for the 
account Web site.

Field Comments
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Associating a Contact with an Account
As you continue to work closely with a prospective account, you manage your 
business relationship with the contacts associated with an account. 

NOTE: Contacts can belong to multiple accounts, only one of which can be the 
primary account.

To associate a new contact with an account 

1 Navigate to the Accounts screen.

2 In the Accounts list, select the account, and then click the Contacts view tab.

3 In the Contacts list, click New, and complete the fields for the contact.

To associate an existing contact with an account

1 Navigate to the Accounts screen.

2 In the Accounts list, select the account, and then click the Contacts view tab.

3 In the Contacts list, click Add.

4 In the Add Contacts dialog box, enter query criteria for the contact, and then 
click Go.

5 Select the contact to add, and then click OK.

To update an external system with an account contact

1 Navigate to the Accounts screen.

2 In the Accounts list, select an existing account, and then click the Contacts view 
tab.

To create a new account, see “Creating an Account” on page 31.

3 In the Contacts list, select the contact.

4 In the contact record, drill down on the contact name hyperlink, and then in the 
contact form, complete any additional fields. 

5 In the Contact form, click the menu button and choose Update External System.
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Account Activities
An activity is a task or event that is generally, but not always, performed for a 
contact, an account, or an opportunity. You will most likely attend meetings, calls, 
and perform other activities associated with an account. You can use the Activities 
list to enter and track account-related activities. If the activity has a time associated 
with it, the activity appears in the Activities list and Calendar. For more information, 
see Chapter 8, “Activities.”

Associating an Account with an Activity
Each account can have multiple activities. Associating accounts with activities 
helps you keep track of what needs to be accomplished for the account.

An account can have a number of activities associated with it. You can associate an 
activity with an account to track which activities you have completed and track 
those you want to accomplish in the future as you manage the account relationship.

To associate an account with an activity

1 Navigate to the Accounts screen.

2 In the Accounts list, select the account associated with the activity.

3 Click the Activities view tab.

4 In the Activities list, click New.

5 In the new activity record, complete the necessary fields.

a In the Type field, drill down on the hyperlink for the default value to change 
the type of activity. 

b In the Display In field, choose the display method for the activity.

For example, the activity can appear in Calendar and Activities, To Do and 
Activities, and Activities Only.
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Associating an Opportunity with an Account
Accounts are a source of business for your company. An opportunity is a potential 
revenue-generating event and the opportunity record stores information that you 
can use to manage accounts.

To associate an opportunity with an account

1 Navigate to the Accounts screen.

2 In the Accounts list, select the account.

3 Click the Opportunities view tab.

4 In the Opportunities list, click New.

A new opportunity record appears, with the Account field, and the Primary 
(team member) field completed. The Close Date field value defaults to the 
opportunity creation date.
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5 Complete the necessary fields for the opportunity.

To display more fields, in the Opportunities list click the menu button and then 
choose Columns Displayed.

The following table describes fields in the Opportunity form.

NOTE: For more information about Opportunities, see Chapter 4, “Opportunities.”

Field Comments

Account A value inherited from the selected account. 

Close Date Allows you to enter the expected date on which the opportunity 
closes. The default date is the opportunity creation date. Modify 
the close date if the opportunity closes on a different date, 
because this date is used in revenue forecasting.

Name Displays the name of the opportunity.

Primary Displays your User ID when you create the opportunity. This 
value can be changed. For more information see, Chapter 4, 
“Opportunities.”

Priority Flag A check box which indicates that an account is a high priority 
(urgency for sales team). When the priority is set by selecting the 
check box, a flag appears in the priority column.

Revenue Allows you to enter the currency amount of the opportunity. This 
field defaults to zero. 

Sales Stage A list of values established by your company that defines the 
sales stages associated with the sales method you selected.
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Updating Account Information in External Systems
If your Siebel Administrator has set up real-time account integration between Siebel 
Sales and a back-office system or other systems in your organization, you can use 
the Update External System command to send new and modified account 
information from Siebel Sales to another system in real-time.

This Application Services Interface (ASI) feature allows you to initiate a real-time 
account data update between Siebel and external system, maintaining consistent 
account information across the enterprise and eliminating manual entry of account 
data in multiple systems.

By default, in the Accounts screen, the Update External System command triggers 
the business process Synchronize Account ASI. This business process sends 
account information to the external system, and updates Siebel with the response 
from the external system. This business process can be viewed by navigating to the 
Business Processes screen from the Site Map, and querying for the business process 
name.

The following procedure explains how to send account information from Siebel 
Sales to another system. The contacts that are associated with the account must 
sent separately to the external system. For more information, see “Updating Contact 
Information in External Systems” on page 28. 

This procedure assumes that your Siebel Administrator has completed the work 
necessary to allow real-time account integration through ASI. For information about 
how to set up the Web services administration to communicate with the external 
system, ASI structures, configuring and customizing the ASI, see Application 
Services Interface Reference: Siebel eBusiness Application Integration Volume VI, 
MidMarket Edition and Applications Administration Guide, MidMarket Edition.

To synchronize account information with an external system

1 Navigate to the Accounts screen.

2 In the Accounts list, select an account record.

To create a new account record, see “Creating an Account” on page 31.

3 In the Account list, click the menu button, and then choose Update External 
System.
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Viewing Account Credit Profiles
If your organization uses back-office software or another external credit 
management system to store customer credit information, you can use the Credit 
Profile read-only view to get the most current account credit profile information.

The Accounts screen’s Credit Profile view allows you to improve employee 
productivity by providing visibility to complete customer information within your 
Siebel application, and streamlines the quote-to-cash process by allowing the sales 
professional to identify potential credit problem early.

This procedure assumes that your Siebel Administrator has completed the work 
necessary to allow real-time account integration through Application Service 
Interfaces (ASI). For information about how to set up the Web services 
administration to communicate with the external system, ASI structures, 
configuring and customizing the ASI, see Application Services Interface Reference: 
Siebel eBusiness Application Integration Volume VI, MidMarket Edition and 
Applications Administration Guide, MidMarket Edition.

To view account credit profile information

1 Navigate to the Accounts screen.

2 In the accounts list, select the account.

3 Click the Credit Profile view tab.

The Credit Profile form appears, and includes information on credit status, risk 
category, credit limit, and so on.

Fields in this form are read-only, except for the Skip Credit flag check box and 
Credit Auto Approval Limit. 

4 Click Refresh to update the information in the Credit Profile form.
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Global Accounts Overview
Available as an option, Global Accounts allow users to see opportunities, activities, 
contacts, and account team information for an account and its subsidiary accounts. 
The Global Accounts view tab is accessed from the Accounts screen.

Global Accounts consist of a parent account, the child accounts, the child accounts’ 
children, and so on. These hierarchies are determined in one of two ways:

■ Hierarchies are determined by the value in the parent field on the Account 
Record.

■ Hierarchies are determined by the administrator who creates custom hierarchies. 

Business Scenario
A large multinational corporation has three major subsidiaries. Each subsidiary has 
two child companies. The Global Accounts Manager plans to review all 
opportunities at the multinational company and its subsidiaries. 

Account records have already been created for the multinational corporation and its 
subsidiaries and the company’s administrator has already created the Global 
Account hierarchy.

The Global Accounts Manager navigates to the Accounts screen, and selects the 
Global Accounts view tab. In this view, the manager can see the opportunities for 
the multinational corporation and its subsidiaries.

Viewing Global Accounts
Global Accounts are created and maintained by the administrator. If an account has 
no child account or the administrator has not defined a hierarchy for an account, 
then a message appears advising you that the selected record is not included as part 
of your defined hierarchy.

For more information on creating Global Accounts and account hierarchies, see 
Applications Administration Guide, MidMarket Edition.
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To view global accounts

1 Navigate to the Accounts screen.

2 From the Show drop-down list, choose My Global Accounts.

Other Show drop-down list options include All Global Accounts, and Global 
Accounts Across Organizations.

The Global Accounts subviews appear, as shown in the following figure, with 
the explorer at left showing the hierarchy of account, subaccounts, contacts and 
opportunities, and the list at right showing records associated with each 
subview.

To view Global Accounts information

■ Click the individual view tabs for Subaccounts, Contacts, Activities, 
Opportunities, and Account Team.

Records associated with these subviews appear in a list at the right of the 
explorer.
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Opportunities 4
This chapter explains how sales professionals can use the Opportunities screen and 
its related views to create, qualify, and close opportunities. This helps sales 
professionals to manage their pipelines and win more deals. 
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Opportunities Overview
An opportunity is defined as a potential revenue-generating event. The following 
scenarios are examples of opportunities:

■ At a trade show, a company representative expresses interest in purchasing a 
product.

■ A telesales representative calls a contact, and the contact expresses interest in 
contracting maintenance services.

■ In a conversation with an existing client, the client expresses an interest in 
upgrading to the newest model.

Opportunity-related information is recorded and tracked in the views associated 
with the Opportunities screen. You can use the Opportunities views to perform the 
following tasks:

■ Receive and respond to new leads that are assigned to you

■ Create new opportunities and enter related information such as accounts, 
contacts, activities, and products

■ View, qualify, and update opportunities assigned to you and your sales team (if 
you are a manager)

■ Track the status of an opportunity through the sales cycle from creation to 
closure

■ Share information about the opportunity with sales team members 

■ Generate quotes and other types of information needed to close the deal
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Business Scenarios
The following business scenarios describe how a typical sales representative works 
with leads and opportunities. Your company may use a different methodology based 
on your business practices.

Opportunity Lead Conversion
A company uses Siebel Campaigns, MidMarket Edition to develop a campaign as 
part of a new product introduction. During the campaign, a telemarketing agent 
uses Siebel Call Center to contact prospects associated with the campaign. During 
her conversations with prospects, the agent qualifies leads by determining whether 
each prospect is interested in the new product offering. When a prospect expresses 
interest in learning more about the new product, the agent creates a new lead.

Using Siebel Territory Assignment Manager the lead is automatically routed to the 
sales representative who is most qualified to work on the lead and whose schedule 
can accommodate the new assignment.

When the sales representative log onto the Siebel Sales application, she sees the 
new lead in the Opportunities list on her home page. Drilling down on the lead takes 
the sales representative to the Opportunities screen. After reviewing details about 
the lead, such as the customer information, probability of closing, and the products 
that the customer is interested in purchasing, the sales representative decides to 
accept the lead by changing the Status field to Accept.

After the sales representative accepts the lead, she begins to work on the lead by 
assembling members of the sales team, conducting further research on the 
customer and its requirements, coordinating and recording activities, uploading 
agreements, and generating informational material for the customer. As the sales 
representative works through the sales cycle, she updates information about the 
sales stage and keeps private notes as well as notes that she shares with other 
members of the sales team. Eventually, the sales representative develops a quote 
from the Opportunities screen. When the customer accepts the quote, it is converted 
into an order.

NOTE: Siebel Campaigns, Siebel Call Center, Siebel Sales, and Siebel Quotes are fully 
integrated, separately licensed product offerings. You need to license these products 
to access the views.
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Opportunity Tracking
At a trade show, a sales representative meets a prospective customer who could be 
a lead for a new business opportunity. When the sales representative returns to the 
office, he discovers the company is listed in Siebel Sales as an account, but the 
person he met is not listed as a contact.

The sales representative proceeds to add the prospective customer as a contact, and 
then creates the opportunity. He then schedules meetings and creates associated 
activities, and enters other potential contacts associated with the opportunity.

As the sales process continues, the sales representative gathers and updates 
information about the account, its contacts, and the opportunity that he is pursuing. 
As the relationship grows, the sales representative can add, view, and share stored 
information and key knowledge with other members of the sales team.

Opportunity Generated Quote
A sales representative is assigned to the sales team for an opportunity. As the sales 
representative gathers product information about the customer requirements, she 
enters that information in the Siebel Sales application. After she presents to the 
customer, the customer indicates that the representative’s company is on the short 
list for the deal, and that the representative should submit a quote. 

The sales representative creates a quote automatically based on the information she 
has already entered into the Siebel Sales application. After she generates the quote, 
she synchronizes the quote information with the revenues associated with the 
opportunity. By making sure these numbers are in sync, the sales representative 
establishes that the data associated with her opportunity is current and that her 
forecasts are accurate.
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Opportunities Screen Views
The Opportunities Screen includes several views that allow you to create, update, 
and track opportunities. These views make it easier to find and review relevant 
opportunities and associated data. For example, you can use the views to access 
opportunities belonging to you, your team, or your organization. 

Table 2 describes each of the views within the Opportunities screen.

NOTE: The views in Table 2 (except for the Manager’s Explorer view) are based on 
a default predefined query (PDQ) shown in the Queries drop-down list. The PDQ is 
labeled * Current Opportunities. Only opportunities that have a Close Date within 
the last 30 days or in the future (>= Today’s Date - 30 days) appears in the view. 
Opportunities without a primary sales representative or an unspecified organization 
do not appear in the views. The administrator can access these opportunities from 
the Site Map > Data Administration > Opportunities view.

Table 2. Opportunities Screen Views

View Description

All Opportunities Displays opportunities whose organization is the same as 
the organization of the user. The user may or may not be on 
the sales team for these opportunities. 

All Opportunities Across 
My Organizations

Displays opportunities which have an organization or a 
suborganization that is the same as the user's organizations.

All Opportunities Across 
Organizations

Displays opportunities for all organizations. Typically only 
select users have access to this view.

Explorer This view makes it easier to visualize the relationship of 
records that have been added to each opportunity. For each 
opportunity, you can view associated child opportunities, 
contacts, products, partners, quotes, activities, and notes. 

Manager’s Explorer Gives managers a view of their team’s opportunities by team 
member.

My Opportunities Displays opportunities for the user’s sales team. 

My Team’s Opportunities This manager’s view displays opportunities associated with 
either the manager’s sales team or the sales team of one of 
his team members. 
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Other Views Associated with the Opportunities Screen
Several view tabs are frequently associated with the Opportunities screen. Table 3 
provides an explanation of each view. Some of these views only appear if you have 
purchased optional add-on modules. Views included in add-on modules are 
indicated by an asterisk (*).

Table 3. Views Associated with the Opportunity Screen

 Opportunity Screen 
Associated Views Comments

Activities Allows sales professionals to identify and track activities required to 
win the deal. Examples of activities are customer calls and team 
meetings. Activities can also be viewed in the Calendar and To Do 
views. For more information see Chapter 8, “Activities.”

Activity Plans Provides templates predefined by the administrator that identify a set 
of activities that should be completed. Activity Plans help sales 
managers to indicate required activities and also saves time for sales 
professionals because the activities are automatically generated based 
on the selected template. For more information see Chapter 8, 
“Activities.”

Attachments Allows sales professionals to associate relevant documents with the 
opportunity. An example is a Microsoft Word Request for Proposal 
document.

Audit Trail Allows users to track changes that have been made to an opportunity 
record. Any time a member of the opportunity sales team creates, 
updates, copies, or deletes opportunity data, the action is tracked in 
the Opportunity Audit Trail view. Audit Trail details which employees 
made the modifications and when these changes were made. Changes 
to the Revenue Class, Probability, Stage, Stage ID, and Status fields are 
automatically tracked. Your administrator can help you set up change 
tracking for additional fields. For more information, see Applications 
Administration Guide, MidMarket Edition. 

Calendar A Calendar format view that shows activities associated with the 
opportunity.

Campaign Leads* Primarily used by call center agents to record a campaign response 
that represents a sales opportunity. See Siebel Call Center User Guide, 
MidMarket Edition for more info.
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Categories Allows you to sort and track information related to the opportunity. 
For more information, see Chapter 12, “Categories.”

Charts Allows you to view graphical analyses of opportunity data.

Competitors Allows you to track competition in the deal. For more information, see 
Chapter 6, “Competitors.”

Contacts Allows you to maintain list of key customer contacts in the 
opportunity.

Messages Allows you to associate phone messages with the opportunity. For 
more information, see Chapter 9, “Messages.”

More Info Used to create, update, and track the status of opportunities.

Notes Allows you to create private notes or public notes that can be shared 
with your sales team.

Organization 
Analysis

Allows you to analyze key contacts and relationships in the 
opportunity and display them graphically in an organization chart.

Organizations Allows you to view organizations associated with the selected record.

Partners Allows you to add partners who can help you win the opportunity.

Products Allows you to associate products with the opportunity.

Profile Allows you to capture key info to qualify the deal. You can attach a 
SmartScript to support this view. For more information, see Siebel Call 
Center User Guide, MidMarket Edition.

Projects* Allows you to create projects to track activities and resources for the 
opportunity. For more information, see Siebel Professional Services 
Automation Guide, MidMarket Edition.

Quotes* Allows you to automatically generate a quote for the offering. For 
more information, see Chapter 13, “Quotes.”

Revenue Plans* Allows you to develop revenue plans. For more information, see Siebel 
Forecasting Guide, MidMarket Edition.

Revenues* Allows you to forecast revenue. Fore more information, see Siebel 
Forecasting Guide, MidMarket Edition.

Table 3. Views Associated with the Opportunity Screen

 Opportunity Screen 
Associated Views Comments
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Sales Team This read-only view allows you to see who is on the sales team for the 
opportunity.

Strategic Selling* Includes views that support the Strategic Selling Opportunity 
Management methodology developed by Miller Heiman, Inc. For 
more information, see Chapter 15, “Strategic Selling.” 

Target Account 
Selling*

Includes views that support the Target Account Selling Opportunity 
Management methodology developed by Siebel MultiChannel 
Services. For more information, see Chapter 14, “Target Account 
Selling.”

Transfer Used to reassign an opportunity to a partner.

Table 3. Views Associated with the Opportunity Screen

 Opportunity Screen 
Associated Views Comments
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Opportunities Processes and Procedures
When you are working with opportunities, you perform a number of key tasks. The 
following tasks are described in this section:

■ Lead assignment

■ Lead response

■ Lead qualification, sales method and stage

■ Creating an opportunity

■ Changing a primary team member 

■ Monitoring significant transactions

■ Associating a contact with an opportunity

■ Associating an activity or activity plan with an opportunity

■ Associating a product with an opportunity 

■ Creating a quote from an opportunity

■ Performing an organization analysis

■ Creating an organization analysis

■ Using drag and drop hierarchy to depict structure

■ Updating contact information for analysis

■ Viewing and printing the organization analysis

■ Adding attachments to opportunities

■ Adding notes to opportunities

■ Viewing charts and reports
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Lead Assignment
You can view new leads in the Opportunities list on your home page, or you can 
navigate to the Opportunities screen to view new leads that you did not create but 
were assigned to you. There are a number of ways in which a lead might be 
assigned to you:

■ A lead is generated through a campaign, and then automatically routed to you 
using Siebel Territory Assignment Manager and predefined rules.

■ A lead is entered into the system by an administrator, and then automatically 
routed to you using Siebel Territory Assignment Manager and predefined rules.

■ An opportunity is created by a sales manager or sales representative who adds 
you to the sales team.

In each of these scenarios, you are able to view the lead or opportunity because you 
have been added to the sales team, either as the primary on the sales team or as a 
sales team member. If you are receiving a lead for the first time and you are the 
primary on the sales team, the Status field in the More Info view is set to Pending 
by default. You can accept, reject, or reroute the lead by changing the value in the 
Status field.

If the administrator has activated the email notifications, predefined processes send 
email messages to you, alerting you of the following events.

■ You have received a new lead and should accept, reject, or reroute the lead 
within seven days.

■ You received a new lead five days ago and should accept, reject, or reroute the 
lead within two days.

■ You have accepted a lead but have not worked on the lead in 30 days.

■ You have won the sales opportunity and should enter the reason in the system.

■ You have lost the sales opportunity and should enter the reason in the system.

The wording of the emails and the wait periods can be modified. Opportunity 
Workflows only sends email if the opportunity has revenue greater than $50,000. 
For more information, see the Opportunity Workflows chapter in Applications 
Administration Guide, MidMarket Edition.
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Lead Response
After you receive a lead, you can choose to accept, reject, or reroute the lead.

■ Rejecting the Lead. You can reject a lead by changing the Status field to Reject in 
the More Info view. Enter the reason for rejecting the lead in the Reason field. 
The lead remains in your queue until it is reassigned by your manager.

■ Rerouting the Lead. If you decide to reroute a lead by changing the Status field in 
the More Info form to Reroute, a Reroute activity automatically is created. Enter 
the reason for rerouting the lead in the Reason field. The lead remains in your 
queue until it is rerouted by your manager.

■ Accepting the Lead. You can accept a lead by changing the Status field in the More 
Info form to Accept. Enter the reason for accepting the lead in the Reason field.

Lead Qualification, Sales Methods and Stages
When you accept a lead, you can begin to work on the lead in the Opportunities 
screen. The records in the Opportunities list include both leads and opportunities. 
Leads are defined as opportunities that have not yet been qualified. 

Lead qualification status is indicated in the Sales Stage field. The list of values in 
the Sales Stage field varies depending on which sales method you are using. 

A sales method is a formalized approach or methodology used during the sales 
process. A sales method can encompass all activities associated with the sales 
process, from prospecting to forecasting to closing deals. This approach allows sales 
representatives to use the method most appropriate for their opportunities. 

The application administrator establishes values in your Siebel application that 
represent the sales methods and sales stages for your company. It is a recommended 
business practice to designate a default sales method in your Siebel application. 
This practice allows a sales method to be associated with each opportunity and aids 
in charting and reporting accuracy.

Sales methods can differ within a company. For instance, a sales method for 
managing a complex multimillion dollar opportunity can include 15 stages, while a 
sales method for a simple low-dollar opportunity may require only four stages.
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Your application administrator creates and implements the sales stages that your 
company uses. For more information about creating or implementing sales stages, 
see Applications Administration Guide, MidMarket Edition.

Table 4 shows sales methodologies (Accelerated, Default, Standard, Strategic 
Selling), and the associated sales stage for each methodology (for example, 01 - 
Prospecting). The table also shows if the record is a lead or is an opportunity at each 
sales stage.

Table 4. Sales Methods and Sales Stages

Accelerated Default and Standard Strategic
Lead or 
Opportunity

01 - Prospecting 01 - Prospecting 01 - Universe Lead

02 - Potential Lead 02 - Above Lead

02 - Qualification 03 - Qualification 03 - In the Funnel Opportunity

04 - Opportunity 04 - Best Few Opportunity

05 - Building Vision Opportunity

06 - Short List Opportunity

07 - Selected Opportunity

03 - Closing 08 - Negotiation 05 - Won Opportunity

09 - Closed or Won Opportunity

04 - Lost 09 - Closed or Lost 00 - Lost Opportunity
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Creating an Opportunity
Each time you identify an opportunity, you should create a new record.

To create an opportunity

1 Navigate to the Opportunities screen.

2 In the Opportunities list, click New.

A new record appears, containing default values for some fields. 

3 In the More Info form, click the show more button.

4 Complete the necessary fields.

The following table describes some fields in the Opportunity form.

Field Comments

Account Allows you to associate an opportunity with an account. 

Address Line 1 Allows you to associate an address with an opportunity. If 
the account has more than one address associated with it, 
you can select the appropriate address for the opportunity.

Best Case Allows you to enter the currency amount the deal could 
generate in the best-case scenario. This amount is higher 
than the value in the Revenue field.

Channel A list of values established by your company that defines 
the sales channel. Default values include Direct and 
Indirect.

Close Date Allows you to enter the expected date on which the 
opportunity closes. The default date is the same as the 
Created Date. It is important to modify the date, if the 
opportunity closes on a different date, because this date is 
used in revenue forecasting.

Committed A check box which, when selected, indicates there is a 
high probability that the deal will close, and that the deal 
should be included in your revenue forecast.

Cost Expense associated with the opportunity.
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Created A default value that displays the date and time you created 
the opportunity.

Created By A default value based on the user ID of the employee who 
created the opportunity.

Description A text area for additional information about the 
opportunity.

Domestic Ultimate DUNS Displays the DUNS number for the domestic ultimate, 
which is the highest member in the hierarchy for the same 
business entity within the same country. A case can be its 
own domestic ultimate.

DUNS# The Data Universal Numbering System (DUNS) numeric 
serial number for a company. The DUNS number is unique 
for each company.

Executive Priority This check box can be used to flag a significant 
opportunity. Sales executives can query for high-priority 
opportunities for tracking purposes.

Expected value Displays a currency value that is calculated based on the 
potential revenue field multiplied by the value in the 
probability field. A lower percentage in the probability 
field reduces the expected value that is included in your 
revenue forecast.

Global Ultimate DUNS Displays the DUNS number for the global ultimate, which 
is the highest member in the hierarchy for the same 
business entity worldwide.

Lead Partner The lead partner field is populated automatically when the 
source of the opportunity is a campaign with a lead 
partner. 

If you create an opportunity from a response, and the 
response had a campaign associated with it, the 
opportunity inherits the lead partner from the campaign. 

If you create a new opportunity and select a campaign as 
the source, the opportunity inherits the campaigns lead 
partner, if it has one. 

Lead Quality A list of values established by your company that allows 
you to rank the quality of the lead. Default values include 
1-Excellent, 2-Very High, 3-High, 4-Fair, 5-Poor.

Field Comments
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Lock Assignment A check box which, when selected, locks the sales team 
assignment so that Siebel Territory Assignment Manager 
does not alter the current opportunity assignment.

Margin A calculated field that displays the revenue figure minus 
the cost.

Name A required value that identifies the opportunity.

Opportunity Currency A list of values established by your company that allows 
you to specify the currency type associated with the 
opportunity. 

Organization A default value that displays the organization name 
associated with the person creating the opportunity. Your 
system administrator sets up organizations in your Siebel 
application. 

You can associate multiple organizations with an 
opportunity.

Parent HQ DUNS Displays the DUNS number of the parent organization’s 
HQ location, if this is a subsidiary record.

Parent Opportunity Allows you to associate an opportunity with a parent 
opportunity. For instance, if you are working a sale for a 
division of a company in which there are numerous 
opportunities, you may associate this opportunity with a 
larger parent opportunity for the entire company.

Partner Approval Status A list of values established by your company that allows 
you to specify the approval status of the lead partner for 
the opportunity.

Primary Displays the user ID of the primary sales team member. 
This value defaults to your user ID if you are creating a 
new opportunity.

Priority A check box which, when selected, indicates that an 
opportunity is a high priority (urgency for sales team). 
When the priority is set to Y, a check mark appears in the 
priority column. This column can appear in the 
Opportunities list and the Opportunities Explorer. The 
default value for this column is N.

Field Comments
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Probability % The Probability reflects the percentage of confidence you 
have that the deal will close with the specified revenue on 
the specified close date. By default, the probability adjusts 
automatically based on the sales stage of the opportunity. 
You can manually override the probability value.

Reason A list of values established by your company that allows 
you to specify a reason that the opportunity was accepted, 
rejected, rerouted, won, or lost.

Revenue Allows you to enter the currency amount of the 
opportunity. If you are using the Products, Quotes or 
Revenue view tabs, you can make sure your summary 
revenues are calculated and are in sync.

Revenue Class A list of values established by your company that allows 
you to define the quality of the expected revenue. For more 
information, see “Revenue Class and Revenue Type” on 
page 59.

Revenue Type A list of values established by your company that allow 
you to define the kind and source of the expected revenue. 
For more information, see “Revenue Class and Revenue 
Type” on page 59.

Sales Method A list of values established by your company that includes 
the sales methodologies. Default values include Strategic 
Selling, Accelerated Sales Process, Default Sales 
Methodology and Standard Sales Process.

Sales Stage A list of values established by your company that allows 
you to specify the sales stages associated with the selected 
sales method. 

Sales Team This list shows who is on the sales team for the 
opportunity. When you create an opportunity, you are 
automatically listed as the primary sales team member. 
You can add employees to the sales team by selecting them 
from the employee list. Only a manager or administrator 
can change or delete the primary sales team member.

Site A default value that is automatically entered when you 
associate the opportunity with a specific account and 
location.

Field Comments
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Revenue Class and Revenue Type
Revenue Class and Revenue Type fields appear on both the Opportunity and the 
Revenue forms. These two fields are the same fields in the database, and they are 
linked through a database join, which means changes made in the Opportunity 
form are reflected on the Revenue form and changes made in the Revenue form 
appear in the Opportunity form. 

The Revenue Class and Revenue Type lists of values are based on the internal 
business process for each company. The standard values can be adapted to your 
business, or the lists of values changed by your application administrator to reflect 
the stages of your company’s sales process and the manner in which your company 
recognizes revenue.

Source A dialog box that allows you to associate the sources of the 
sales lead with the opportunity. Typical source values 
include specific events, campaigns, or conferences.

Source Type A default value that displays the category of the primary 
source. For instance, a specific seminar that is the source 
of the opportunity is identified with a value of Seminar in 
this field.

Split Flag A system populated check box that indicates a split 
revenue record has been created.

Status  A list of values established by your company that 
describes the status of the opportunity. The Status field is 
Pending by default. A user can change the field to 
Accepted, Rejected, Rerouted, Won, or Lost.

Territories A default value based on the territories defined by your 
company. Your system administrator controls the territory 
assignment function set up by your sales manager.

Worst Case Allows you to enter the currency amount the deal could 
generate in the worst-case scenario. This amount is lower 
than the value in the Revenue field.

Field Comments
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Revenue Class Field
Your company can define the quality of the revenue at a given time by setting the 
list of values in the Revenue Class field to reflect the sales stages you use. Sample 
values are Pipeline, Upside, Expected, Committed, and Closed.

Revenue Type Field
Your company may want to differentiate between kinds of revenues and their 
sources. For instance, your company may classify revenue by Software, Consulting, 
and Hardware categories, or by Booked versus Billed revenue, which are defined in 
the list of values. Defining revenue types allows you to query revenues or view 
charts sorted by the category of the revenue.

For more information, see Applications Administration Guide, MidMarket Edition.

Changing a Primary Team Member
The administrator or manager of the primary sales representative can change the 
person assigned as the primary member of the sales team.

To change a primary team member

1 Navigate to the Opportunities screen.

2 From the Show drop-down list, choose My Team’s Opportunities.

3 In the Opportunities list select the opportunity, and then click the More Info view 
tab.

4 In the More Info form click the select button in the Sales Team field.

5 In the Team Members dialog box select the team member to assign, and then 
select the Primary check box.

6 Click OK.
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Monitoring Significant Transactions
Sales executives can monitor significant opportunity transactions by querying for 
opportunities flagged as Executive Priority. These flagged opportunities can be 
tracked by the executive team regardless of the revenue or forecast commitment. 
Tracking high-priority opportunities helps the executive maintain the most accurate 
quarterly revenue forecast and plan involvement in the most promising 
opportunities.

To flag an opportunity as an executive priority

1 Navigate to the Opportunities screen.

2 In the Opportunities list, select the opportunity.

3 In the Opportunities list, click the menu button and choose Columns Displayed.

4 In the Columns Displayed dialog box, move Executive Priority and Executive 
Priority Date from the list of Available Columns to the list of Selected Columns, 
and then click Save.

The fields appear in the record for the selected opportunity.

5 In the opportunity record, click the check box in the Executive Priority field.

The Executive Priority Date field automatically shows the current date after the 
Executive Priority flag is checked.

Associating a Contact with an Opportunity
As you work with an opportunity, you want to maintain information about the 
contacts associated with the opportunity. For more information about contacts, see 
Chapter 2, “Contacts.”

The Opportunity screen’s Contacts view allows you to store and review contact-
related information for an opportunity.

To associate a new contact with an opportunity

1 Navigate to the Opportunities screen.

2 In the Opportunities list, select the opportunity.

3 Click the Contacts view tab, and in the Contacts list click New.

4 In the new record, complete the fields.
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To associate an existing contact with an opportunity

1 Navigate to the Opportunities screen.

2 In the Opportunities list, select the opportunity.

3 Click the Contacts view tab, and in the Contacts list click Add.

4 In the Add Contacts dialog box, enter query criteria for the contact, and then 
click Go.

5 Select the contact or contacts you want to add, and then click OK.

NOTE: To select a sequence of contact records, hold down the SHIFT key and click 
the contact records. To select multiple contacts that are not in sequence, hold down 
the control key and click the contact records.

Activities or Activity Plans Associated with an Opportunity
The Opportunities screen’s Activities view allows you to track activities at the 
opportunity level, maintain a calendar and to-do list for the opportunity, and 
delegate activities related to the opportunity to your sales team. For more 
information about Activity Plans and associated activities, see Applications 
Administration Guide, MidMarket Edition and Chapter 8, “Activities.”

Associating a Product with an Opportunity
Specific products can be associated with an opportunity. For example, if a customer 
is interested in purchasing a new software suite, this information can be specified 
in the Products view.

After the product is associated with the opportunity, you can drill down on the 
product to review additional information such as product features and prices.

Later, this data can be used when you are building a quote based on the 
opportunity.
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To associate a product with an opportunity

1 Navigate to the Opportunities screen.

2 In the Opportunities list, select the opportunity.

3 Click the Products view tab, and in the Products list click New.

4 In the new record, click the select button in the Products field.

5 In the Pick Product dialog box, enter product criteria and then click Go.

6 Select the product and then click OK.

The product appears in the Opportunity Products list.

7 Complete the remaining fields, as needed.

After the product record is saved, you can drill down on the hyperlink in the 
Product field to view Product details such as Key Features and Product Images.

Creating a Quote from an Opportunity
Using the Quotes view, you can automatically create and revise quotes for the 
opportunity. For more information, see Chapter 13, “Quotes.”

To create a quote from an opportunity

1 Navigate to the Opportunities screen.

2 In the Opportunities list, select an opportunity.

3 Click the Products view tab.

4 In the Products list click New, and then add a product.

For more information, see “Associating a Product with an Opportunity” on 
page 62.

5 In the Product record, complete the fields.

a Enter the number of product units the customer is interested in purchasing

b In the Auto Quote field, select the check box to display a check mark.
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6 Click the Quotes view tab, and then in the Quotes list click Auto Quote.

A quote record is automatically created, with some fields completed and a status 
of In Progress.

If a price list is associated with the account, the Price List field is automatically 
completed. If no price list is associated, in the Price List field click the select 
button and choose a price list. For more information on price lists, see Pricing 
Administration Guide, MidMarket Edition.

7 In the quote record, drill down on the hyperlink in the Name field.

You can change the system-generated name for a name that is more meaningful 
in the quote details form.

8 In the quote’s Line Items list, add line items, and then click the menu button and 
choose Reprice.

The Reprice function makes sure that the quote total reflects the prices from the 
price list, and multiplies those prices by the quantities that you enter in the 
products view.

9 In the Quote form, click the menu button and choose Update Opportunity, and 
then return to the Opportunity form.

The Update Opportunity function verifies that the opportunity's revenue line 
items are in sync with the quote line items.

Use the History icon or the threadbar to navigate back to the Opportunity form.

To update opportunity revenues

1 In the Opportunity list, select the opportunity and then click the Revenues view 
tab.

2 In the Revenues list choose List from the Revenues drop-down menu.
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3 In the Revenues list, click the menu button and choose Update Opportunity.

Update Opportunity makes sure that your summary level revenues equal the 
sum of your revenue line items.

After this process is completed, the revenue amounts that appear in the 
Products, Revenues, and Quotes views are synchronized and the Opportunity’s 
Revenue field displays a calculated sum of the individual revenue line items 
associated with the opportunity.

NOTE: Siebel Quotes is a separately licensed product offering. You cannot access the 
Quotes view tab if you have not licensed this product.
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You can automatically create organization charts to help you analyze your key 
contacts and develop your relationship strategy to win the opportunity.

Creating an Organization Analysis
Siebel Sales automatically generates organization charts based on contacts 
associated with each opportunity. When you update contact information, your 
changes are reflected in the organization chart.

To add existing contacts to the organization analysis

1 Navigate to the Opportunities screen.

2 In the Opportunities list, select the opportunity for the Organization Analysis.

3 Click the Organization Analysis view tab.

4 In either the default Organization Analysis chart view or in the Contacts list 
(toggle view), click New.

The Add Contacts dialog box appears.

5 Select one or more contacts to add and then click OK.

NOTE: You can select sequential contacts by holding down the SHIFT key while 
selecting the contact records.

To create new contacts for the organization analysis

1 Navigate to the Opportunities screen.

2 In the Opportunities list, select the opportunity for the Organization Analysis.

3 Click the Organization Analysis view tab.

4 In either the default Organization Analysis chart view or in the Contacts list 
(toggle view), click New.

5 In the Add Contacts dialog box, click New.
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6 In the new contact record enter the contact information in the fields, and then 
click Save.

NOTE: If you create a new contact directly from the Organization Analysis chart 
view, then an explicit Save is required to update the chart.

The Level of Influence value determines the degree of shading that appears in 
the Contact node in the Organization Analysis chart. The following table details 
values and shading.

You can update contact information from either the Opportunities screen or from 
the Contacts screen. 

Using Drag and Drop to Depict Organization Hierarchy
From the Organization Analysis chart view you can drag and drop contacts to 
indicate professional relationships within the organization.

To create the hierarchy

1 Navigate to the Opportunities screen.

2 In the Opportunities list, select the opportunity for the Organization Analysis.

3 Click the Organization Analysis view tab.

4 Add or create contacts, as described in “To add existing contacts to the 
organization analysis” on page 66 and “To create new contacts for the 
organization analysis” on page 66.

In the Organization Analysis chart area the nodes (boxes) appear for each of the 
contacts you have analyzed and associated with the opportunity.

Value in Level of Influence Fields Shading on Organization Chart

Low None

Political Structure (Medium) Light gray

Inner Circle (High) Dark gray
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5 Select the contact node and drag it beneath the contact node that depicts the 
contact’s manager.

When you drop the contact node on its manager’s node, a formal line between 
the nodes appears, reflecting the reporting relationship.

6 Repeat Step 5 for each contact until you have completed the organization chart.

NOTE: The reporting relationships are also stored in the Contacts list (toggle 
view). The Manager’s Last Name and Manager’s First name fields of the contact 
automatically populate based on the drag and drop actions. To expose this 
information in the contacts list, click the menu button, and then choose 
Columns Displayed.

Drawing Lines of Influence
You can also map the politics in the customer organization by identifying informal 
lines of influence between contacts. Mapping informal lines of influence helps you 
identify contacts who are not highly ranked (and are easier to access) but who have 
significant influence on key decision makers. Lines of Influence information is 
automatically updated in the Contacts screen’s Relationships view. You can add 
Lines of Influence information in the Relationships view if you prefer.

To draw lines of influence

1 In the Organization Analysis chart area, select the contact node, and 
simultaneously hold down the CTRL key.

2 Drag and drop the selected contact on other contacts to draw the lines of 
influence.

The CTRL key must be depressed throughout this process in order for the 
informal line of influence to appear.

To delete lines of influence

■ In the Organization Analysis chart area, select the line and press the DELETE 
key.

You may also right click the mouse in the Organization Chart area, and choose 
Edit > Delete from the menu.
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Viewing and Printing the Organization Analysis
After you associate contacts with an opportunity and enter values for the manager, 
reports, associates and the influence level for each, you can view an organization 
chart of all your contacts. 

To view the Organization Analysis chart

1 Navigate to the Opportunities screen.

2 In the Opportunities list select the opportunity.

3 Click the Organization Analysis view tab.

The Organization Analysis list of contacts appears.

4 From the drop-down list, choose Organization Analysis.

An organization chart appears with the contact information you entered.

Each contact appears in a hierarchy based on the influence level or managerial 
structure assigned to the contact. 

NOTE: Double-click the contact node to navigate to the Contacts screen’s Activities 
view to add follow-up activities for the contact.

To print an Organization Analysis chart

1 Navigate to the Opportunities screen.

2 In the Opportunities list, select the opportunity for which you want to view the 
Organization Analysis.

3 Click the Organization Analysis view tab.

The Organization Analysis list of contacts appears.

4 From the drop-down list, choose Organization Analysis.

5 Right click the mouse in the Organization Analysis chart workspace, and choose 
Print from the menu.

You can adjust the zoom level at which you want to print the Organization 
Chart. Large charts print across multiple pages.
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Adding Attachments to Opportunities
The Attachments view allows you to associate relevant files such as strategic 
information documents that other sales team members can use as they work this 
opportunity.

To add attachments

1 Navigate to the Opportunities screen.

2 In the Opportunities list select the opportunity, and then click the Attachments 
view tab.

3 In the Attachments list, click New.

4 In the new record, click the select button in the Attachment Name field, and in 
the Add Attachments dialog box, click Browse to navigate to the file.

5 In the Choose File dialog box, locate the file and then click Open.

The file name and path appears in the Add Attachments dialog box.

6 In the Add Attachments dialog box, click Add.

The Attachment name, size, type and modified fields are automatically 
completed for the record, and the Update File field is checked.

7 In the Comments field for the attachment record, enter a description of the 
attachment.

Adding Notes to Opportunities
You can add private notes, or public notes that are shared with members of the sales 
team using the Notes view tab.

To add private and public notes to the opportunity

1 Navigate to the Opportunities screen.

2 In the Opportunities list, select the opportunity and click the Notes view tab.

3 In the Notes list, choose Public or Private from the drop-down menu to specify 
a private note or one that is shared.
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4 In the Notes list, click New, and complete the fields for the new record.

The Created By field is automatically completed with the creator’s User ID.

a In the Type field, select the note type.

Examples of note types are legal, reference, and directions.

b In the description field, enter the note text.
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Several charts are available that support analysis of opportunities data. The data can 
be depicted in a variety of formats such as pie graph, bar graph, and so on. 

Table 5 describes each opportunity analysis chart.

Table 5. Opportunities Charts

Chart Description

Lead Analysis This chart displays the number of opportunities or 
revenue by organization or primary sales representative. 
The data is segmented by lead quality. 

Lead Source Analysis This chart displays the number of opportunities, 
revenue, or average revenue by time period. The data is 
segmented by lead source.

Lead Source Pipeline Analysis This chart displays the number of opportunities by sales 
stage and lead source.

New Business Analysis This chart displays the number of opportunities, 
revenue or average revenue over a time period.

Opportunity Analysis This chart displays the number of opportunities by 
product, source, territory, and competitor.

Pipeline Analysis This chart displays the number of opportunities or 
revenue by sales stage, organization, revenue size, or 
sales method.

Sales Pipeline Analysis This chart displays the percentage of revenue quota and 
percentage of count quota.

Sales Pipeline Phases Analysis This chart displays sales pipeline phases and the 
percentage of revenue quota or count quota achieved 
per phase.
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Querying for Sales Method
To view the different sales methods in chart form, you must perform a query in the 
Sales Stage field of the Opportunity screen. The chart appears when the sales 
method is queried for opportunities. After you have performed the query, select the 
pipeline chart to display the results.

To query for a sales method

1 Navigate to the Opportunities screen.

2 From the Show drop-down list, choose All Opportunities.

3 In the Opportunities list, click Query.

4 In the Opportunities form, query on a Sales Stage and then click Go.

5 Click the Charts view tab.

6 In the Charts view, from the Show drop-down list, select the appropriate chart. 

Viewing the Opportunity Sales Pipeline Analysis Chart
The Sales Pipeline Analysis works by evaluating the total revenue and count of 
opportunities by a selected sales methodology and then evaluating the total against 
each applicable quota.

NOTE: The Sales Pipeline Analysis Chart considers only active Quota plans, 
regardless of duration. 

To display sales pipeline analysis information

1 Navigate to the Opportunities screen.

2 In the Opportunities list, select the opportunity to graph.

3 Click the Charts view tab.

4 In the Charts list, select Sales Pipeline Analysis from the Show drop-down list.

5 From the secondary Show drop-down list, choose either % of Count Quota, or 
% of Revenue Quota, and then click Go.
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Viewing the Sales Pipeline Phases Analysis Chart
The Sales Pipeline Phases chart provides an overall view of the revenue generated 
for opportunities in an organization. Sales phases are basic components used to 
group stages together into basic sales categories.

To view the sales pipeline phases analysis chart

1 Navigate to the Opportunities screen.

2 In the Opportunities list, select the opportunity.

3 Click the Charts view tab.

4 In the Charts list, select Sales Pipeline Phase Analysis from the Show drop-down 
list.

5 From the secondary Show drop-down list, choose either % of Count Quota, or % 
of Revenue Quota, and then click Go.
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Opportunity Reports
You also can generate reports of your opportunities data. Available reports include:

■ Opportunities by Category

■ Opportunities by Sales Rep

■ Opportunity Summary

■ Opportunity List

■ Pipeline Report by Rep

■ Smart Report - Opportunity Detail

■ Opportunity Status

■ Opportunity Marketing Events Summary

Generating Opportunity Reports
Use the following procedure to run opportunity reports. 

To generate an opportunity report

1 Navigate to the Opportunities screen.

2 In the Opportunities list, select an opportunity.

3 From the application-level menu, choose View > Reports.

The Reports dialog box appears.

4 From the Select a Report drop-down list, choose the report to display, and then 
click Run Now to immediately generate the report.

To generate the report at a later time, click Schedule, and then complete the 
fields in the Reports dialog box.
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Configuring the Opportunities by Category Report
The Opportunities by Category report can be configured to sort by City, Close Date, 
Sales Cycle Stage, Source, Source Date, State, Territory, or ZIP Code.

To configure the Opportunities by Category report

1 Navigate to the Opportunities screen.

2 In the Opportunities list, select an opportunity.

3 From the application-level menu, choose View > Reports.

4 In the Reports dialog box, choose the Opportunities by Categories report from 
the Select a Report drop-down list, and then click Run Now.

5 In the Opportunity Parameters dialog box, choose a sort parameter in the Sort 
By field, and then click Finish.
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This chapter explains how to use D&B data and reports to manage customer 
relationships, acquire new customers, and create high quality new account records.
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D&B Overview
You can integrate D&B data and reports into your Siebel application, allowing you 
to perform the following tasks:

■ Use D&B information to standardize data for your customer accounts

■ Access D&B business and credit reports

■ Search D&B for new accounts

■ Generate prospect lists based on D&B relationships and demographic data

■ View account hierarchies and related opportunities across a corporate family 
structure

D&B data supports the following:

■ Customer acquisitions

■ Sales call planning
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Business Scenarios
The following business scenarios describe some ways in which you can use D&B 
data in your Siebel application.

Relationship Management
A company can increase market penetration across its existing customer base by 
determining how many relationships the company already has within a corporate 
family structure. Sales managers and representatives can use D&B D-U-N-S numbers 
to view the organizational hierarchies of clients and aggregate account attributes at 
each level.

For instance, a sales representative plans to sell computers to 20 business locations 
and he discovers that there are locations for this company that he has not yet 
contacted. In another situation, the sales manager many want to see a rollup of 
opportunities and the potential revenue for each subsidiary and location for a 
specific company on a worldwide basis.

Customer Acquisition
Because a sales organization is always looking for more leads to new business, sales 
professionals can access company information in the Siebel D&B database, allowing 
them to generate prospects in their territories.

With D&B, the sales representative can query the Siebel D&B database using criteria 
to target new leads. The sales representative can query using demographic data, 
revenue profiles, or other criteria. After generating a list of leads, the sales 
representative can automatically add the companies and contacts to their 
company’s accounts list. These promoted accounts and contacts are automatically 
updated when D&B updates occur.
Version 7.5 Siebel Sales User Guide MidMarket Edition 79



D&B Integration

Business Scenarios
D&B Search for New Account Information
Sales professionals can access the D&B database real-time to find and retrieve new 
D&B account information that is immediately available for use within Siebel Sales. 
This information includes company demographic, corporate linkage, and address 
data maintained by D&B.

For example, a sales representative discovers a new opportunity, but the 
representative cannot find the account in either the Siebel account list or the D&B 
account list. Instead of creating a new account, the sales manager performs a real-
time D&B search to obtain up-to-date, quality information that can be used to 
automatically establish a new Siebel account. This provides the sales team with 
valuable information that they can use when working on the new opportunity.
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Using D&B
The D&B screen allows you to access D&B marketing data as well as business and 
credit reports from within the Siebel Sales application. D&B allows you to create 
targeted marketing lists, supply corporate linkage information, and provide you 
with online access to selected D&B business and credit reports.

You can directly access D&B data for use in prospecting, qualifying leads, and 
generating marketing lists.

D&B D-U-N-S Number
The D-U-N-S (Data Universal Numbering System) number is an important 
component of D&B data. The D-U-N-S number is a unique nine-digit identifier 
assigned to each business entity in the D&B database.

D&B links the D&B D-U-N-S numbers of parents, subsidiaries, headquarters, and 
branches on more than a million corporate family members around the world.

Viewing D&B Data
When you have the D&B account information loaded into your Siebel Sales 
application, a number of views allow you to use the data and view company 
hierarchies. The following procedure explains how to view aggregate data for a 
company using the D&B screen.

NOTE: D&B data for a company is read-only until it is promoted to a Siebel account.

To view aggregate data

1 Navigate to the D&B screen.

2 In the D&B Accounts list select the account for which you want to view the 
aggregate data.
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3 In the More Info form, click Query.

4 In the query form, enter the query criteria, and then click Go.

A list of D&B accounts that meet your criteria appear.

NOTE: If the DUNS # field does not appear in the list, click the menu button, 
choose Columns Displayed, and adjust the list of displayed columns.

Promoting a D&B Account
You can use the D&B list to locate accounts that are potential sales leads. After you 
identify accounts that meet your criteria, you can promote the accounts into your 
accounts list.

To promote a D&B account

1 Navigate to the D&B screen.

2 In the D&B Accounts list select the company or companies that you want to add 
to your accounts list.

NOTE: To select a sequence of account records, hold down the SHIFT key and 
click the account records. To select multiple accounts that are not in sequence, 
hold down the CTRL key and click the account records.

3 In the D&B Accounts list, click Promote as Siebel Account.

A check mark appears in the Promoted field and the company is added to your 
Siebel Sales application. 

NOTE: Drill down on the hyperlink in the Business Name field to view the 
account profile and related contacts.
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Creating a Prospect List
You can use D&B data to generate sales leads. One way to use sales leads is to create 
a prospect list for your telesales or sales team to contact.

To create a prospect list

1 Navigate to the D&B screen.

2 In the D&B Accounts list select the company or companies that you want to 
include in your list, and then click Create D&B Lists.

The contacts associated with the company or companies are added to a prospect 
list.

3 To view the prospect list, select D&B Lists from the Show drop-down list.

4 In the D&B Lists list, select the list and drill down on the list name hyperlink to 
view accounts on the list.

Viewing a D&B Report
After a D&B report order is set up by your administrator, you can view business and 
credit reports within your Siebel application.

To view a D&B report

1 Navigate to the D&B screen.

2 In the D&B Accounts list select the company for which you want to view reports.

3 Click the Reports view tab.

The D&B report for the selected company appears.

NOTE: This information can also be viewed from the Accounts screen’s D&B Reports 
view tab.
Version 7.5 Siebel Sales User Guide MidMarket Edition 83



D&B Integration

Global Integration and Adding New D&B Accounts
Global Integration and Adding New D&B Accounts
After a D&B Global Integration access is set up by your administrator, you can 
access D&B real-time within your Siebel application and enter criteria to locate new 
accounts in the D&B database. Search criteria can include the business name with 
state/province and country information, D&B D-U-N-S number, local business ID, 
and telephone number.

Searching D&B for New Accounts
When you execute a search for new D&B accounts, the search criteria is sent to 
D&B's Global Integration, along with the user’s D&B account name and password. 
When D&B receives the information, Global Integration automatically selects the 
single best search method to execute based on the criteria. D&B calculates the 
criteria matches and returns the number to Siebel. If there are no matches for the 
criteria, the requestor is notified.

At this point, you can opt to purchase the account information, or cancel the Global 
Integration search process. If an account is purchased, data received from D&B is 
added to the Siebel D&B tables and is available in D&B All Accounts view.

NOTE: If the selected account already exists in your Siebel D&B database, the 
account is not purchased. 

To initiate D&B’s Global Integration search

1 Navigate to the D&B screen.

2 In the D&B Accounts list, click Search D&B for New Account.
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3 In the Search D&B dialog box, complete the fields for the query.

The following illustration shows an example of the search criteria form.

You must enter sufficient data to initiate a query in the United States. For 
example, as the following figure shows, in the Search D&B form you can enter 
Business Name, State/Province and Country as criteria, or just the DUNS #, or 
the Local Business ID and Country, or the Phone number and Country. If you 
only enter the Business Name, the search fails because the data is insufficient.
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The following table describes the Search D&B query fields.

Field Comments

Business Name The Name/Address search is the most commonly used 
search method. At a minimum, the business name and 
country must be supplied. For Canadian businesses, the 
province must also be included. 

When you are searching for a business by name, do not 
use wildcard characters, (*) for unknown characters in 
the name.

Additional information such as town, street address, 
and postal code, can be included to increase the 
chances of finding an exact match.

Street Address

City

State/Province

Country Name

Zip Code

DUNS # This search method allows you to enter a known D&B 
D-U-N-S number to verify the identity of a business. 
The D&B D-U-N-S number should contain only nine 
numeric characters (no spaces, dashes, and so on). 
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Local Business ID Many countries have their own numbering schemes to 
identify local businesses. Normally, this is a 
government-sponsored schema for the purpose of 
business registration and tax filing. 

The local business ID submitted in a search should only 
contain numeric characters (no spaces, dashes, and so 
on). A country code must also be included with the 
request. 

D&B Global Integration supports searching by the 
following local business identifiers.

Australia—CAN 

Belgium—BTW/TVA

France—SIREN

Germany—Hr. Number

Ireland—Company House

Italy—CCIAA

Netherlands—KvK Nr

Portugal—Fiscal

Spain—CIF/NIF

Sweden—Company House

United Kingdom—Company House

Phone # If using a telephone number search, enter the telephone 
number as dialed from within the country, including 
the area code or city code if required. The international 
long distance code (country code) should not be 
included. 

For example 9086655000 for a search in New Jersey, US; 
9055686000 for a search in Ontario, Canada; 
01494422000 for a search in High Wycombe, England; 
0104009400 for a search in Rotterdam, Netherlands. 

The telephone number should contain only numeric 
characters (no spaces, dashes, and so on).

Field Comments
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4 After you have entered the criteria, click Search D&B.

The following figure shows sample search results, with the business name, city, 
and state in the Search Results list.

5 In the Search D&B list of results, select an account and then click Purchase.

Click Refine Query to modify the query criteria. Click Cancel to return to the 
D&B Accounts list without purchasing.

The purchased account is highlighted in the D&B Accounts list.
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This chapter explains how to use the Competitors screen to examine comparisons 
of your company and competitors, view comparative literature of your products and 
those of your competitors, and associate a competitor with an opportunity.
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Competitors Overview
A competitor is an organization that buys or sells products or services similar to 
those of your organization. The Competitors screen provides you with useful 
information and literature about your competitors and their products. This 
information can be used in preparation for a sales call, or during a telephone 
conversation to differentiate your offerings from those of your competitors.

You can use the Competitors screen to perform the following tasks:

■ View a list of your competitors and their products

■ Display your competitor’s literature and literature that compares your 
company’s products and services to those of your competitors

■ Compare your company and products to your competitor’s company and 
products

Business Scenario
A sales representative logs into the Siebel Sales application and discovers a newly 
qualified opportunity. He navigates to the Competitors view to review the 
competition for the opportunity. One competitor is listed for the deal. The sales 
representative is not familiar with the company and drills down on the competitor 
name hyperlink to learn more.

In the Company Comparisons view, the representative can view a side-by-side 
comparison of his company and the competitor’s company. You have access to 
competitive intelligence documents compiled by your company about this 
competitor, as well as literature items that the competitor has published.

In the Competing Product Comparisons view, you can view a detailed, side-by-side 
comparison of your company’s products compared to the competitor’s products. 
You navigate to the Product Literature view and send a document to your sales team 
to help prepare for the next sales call.
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Working with Competitive Information
In competitive sales situations, it is imperative to have information about your 
competitors to strengthen your sales strategy and differentiate your company's 
image and offerings. 

Associating a Competitor with an Opportunity
Associating a competitor with an opportunity notifies your sales team about the 
competition for that deal and provides them with a link to the information the sales 
team needs to deliver a consistent, winning sales strategy.

To associate a competitor with an opportunity

1 Navigate to the Opportunities screen.

2 In the Opportunities list, select the opportunity with which you want to 
associate the competitive information.

3 Click the Competitors view tab.

4 In the Competitors list, click New.

5 In the Add Competitors dialog box, select the competitor and then click OK.

6 In the Competitors list, complete the fields as needed.

TIP: Drill down on the hyperlink in the competitor Name field to navigate to the 
Competitors screen to obtain more information.

The following table describes fields in the Competitor record.

Field Comments

Comments A text field that allows you to record additional 
information about the competitor.

Name Displays the competitor’s company name as a hyperlink. 

Primary A check box which, when selected, indicates that the 
competitor is the primary rival for the deal.
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Status A list of values established by your company that allows 
you to specify the prospect’s interest level in the 
competitor’s offerings. Default values include Some 
Interest, Evaluation in Progress, Existing Relationship, and 
Not Satisfied.

Threat A list of values established by your company that allows 
you to specify the value of the competitor’s threat. Default 
values include 1-Low, 2-Medium, 3-High, 4-Very High.

Field Comments
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Competitor Comparisons
In many sales situations it is necessary to discuss competitive information with a 
prospect. Using the Competitors screen, you can view comparisons about 
companies, products, and services, and also find literature to prepare for sales calls.

Viewing Company Comparisons
To learn more about the competitor’s company and products, you can view 
competitor comparison information.

To view company and comparisons

1 Navigate to the Competitors screen.

2 In the Competitors list, select the competitor.

3 Click the Company Comparisons view tab.

The Company Comparisons, Competitor’s Literature, and Comparative 
Literature lists appear, as shown in the following figure.

To view competitor literature

1 Navigate to the Competitors screen.

2 In the Competitors list, select the competitor for which you want to view 
company literature.

3 Click the Company Comparisons view tab.

4 In the Competitor’s Literature list, select the literature item you want to view.

5 Drill down hyperlink in the Name field to view the literature item.
Version 7.5 Siebel Sales User Guide MidMarket Edition 93



Competitors

Competitor Comparisons
Viewing Comparative Literature
You can view literature that compares your products with those of your competitors. 
After you determine the advantages of your product over the competition, you can 
use this information in your sales strategy.

To view comparative literature

1 Navigate to the Competitors screen.

2 In the Competitors list, select the competitor for which you want to view 
comparison literature.

3 Click the Company Comparisons view tab.

4 In the Comparative Literature list, select the literature item you want to view.

5 Drill down on the hyperlink in the Name field to view the comparative literature 
item.
94 Siebel Sales User Guide MidMarket Edition Version 7.5



Products 7
This chapter explains how sales professions can use the Products screen and its 
related views to address a customer’s questions about products and their features, 
review and provide the customer with product comparisons, and view price lists 
and associated products.
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Products Overview
Products can be physical goods or intangible items such as service, sales 
agreements, or sales promotions. While working on an opportunity, you can use the 
Products screen and related views to view additional information about a product 
and its features. 

This chapter describes ways in which you can view product information, but you 
cannot make changes or update product information. For more information about 
your company’s products, see your application administrator.

Business Scenario
A prospective customer calls to ask specific questions about a product you sell. The 
prospect is interested in the features of a specific service package and how it 
compares to the next higher level of service package you offer. You can view this 
information and provide the prospect with more details about each offering.
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Working with Products
Using the Products screen and its related views allows you to address a customer’s 
questions about the products and their features.

Viewing Product Features and Images
The Products screen, Features and Image view allows you to view details about the 
product and view an image of it, if an image is associated with the product. The 
features and image view is read-only. Your application or product administrator 
maintains the product information for your company.

To view product features and image information

1 Navigate to the Products screen.

2 In the Products list, select the product.

3 Click the Features and Image view tab.

NOTE: You can also view product features and image information from the Quotes 
screen and the Opportunities screen.
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Viewing Product Comparisons
Product comparisons present a feature-by-feature comparison between related 
products. You can use comparisons when you are prepare for meetings, sales calls, 
or when you are speaking to a prospect on the telephone.

To view product comparisons

1 Navigate to the Products screen.

2 In the Products list, select the product for the comparison.

3 Click the Product Comparison view tab.

The Product Comparison list appears. 

Viewing Product Literature
You can view literature associated with a particular product. Literature items can 
include data sheets, white papers, marketing collateral, and so on.

To view product literature

1 Navigate to the Products screen.

2 In the Products list, select the product.

3 Click the Literature view tab.

a In the Literature list, click Query.

b In the query form, enter query criteria and then click Go.

4 In the Literature list, drill down on the hyperlink in the Title field.

The literature opens in the format in which it was saved.
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Viewing Price Lists
You can view price lists to locate the price list associated with a particular product.

To view price lists

1 Navigate to the Products screen.

2 In the Products list, select the product.

3 Click the Price Lists view tab.

4 In the Price Lists list, click Query, enter query criteria in the form, and then click 
Go.

The price list appears in the list.

5 To view additional information, drill down on the hyperlink in the Price List 
field.

Viewing Related Products
When you discuss products with a prospect or customer, you may need to consider 
related products to substitute because products may be back ordered, sold out, 
delayed in shipping, or unavailable for other reasons.

To view related products

1 Navigate to the Products screen.

2 In the Products list, select the product, and then click the Related Product view 
tab.

3 In the Related Product list, drill down on the product name hyperlink.
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This chapter explains how to use the Activities screen and associated views to track 
tasks and events performed for contacts, accounts, and opportunities. Activities can 
be associated with accounts, contacts, and opportunities, and activity templates 
with predefined activities can be created and used company-wide.
Version 7.5 Siebel Sales User Guide MidMarket Edition 101



Activities

Activities Overview
Activities Overview
Your Siebel application tracks various tasks or events performed for contacts, 
accounts, and opportunities as Activity records. Activities can be grouped into lists 
and activity templates created for use across the company.

Using activities, you can assess the investment in time and resources to maintain 
and grow the account relationships. Sales managers also have a record of the 
activities of their sales representatives as they manage account relationships. Sales 
teams can use activities to avoid duplicating efforts across the team, and to share 
information about pending and completed activities. 

NOTE: Activities that are assigned specific dates and times appear on both the 
Activities and the Calendar screens. For more information, see Fundamentals, 
MidMarket Edition.

Business Scenario
A customer plans to visit the headquarters of a software company to meet with 
executives and view a product demonstration. In preparation for the event, the sales 
manager creates and delegates to her team several activities such as preparing 
slides, reserving a conference room, and configuring a demo. To make it easier to 
track these activities, the sales manager assigns the activities so that they appear in 
the team members’ calendars and to-do lists.

As the manager and sales team members complete the activities, the activities are 
marked as done, providing important progress information about the opportunity.
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Working with Activities
An activity is a task or an event that you plan to complete or to delegate to a 
colleague for completion. In Siebel Sales, activities are associated with an account, 
a contact, or an opportunity.

Creating an Activity
During a typical workday you have new tasks to complete. By creating a new 
activity record, you make sure your team members know about the activity, and you 
create a valuable history of your completed and planned interactions with 
customers.

To create an activity

1 Navigate to the Activities screen.

2 In the Activities list, click New.

3 In the new record, complete the necessary fields.

4 Choose an appropriate value in the Display In field.

The Display In value determines where the activity appears:

■ If you only want the activity to appear in the Activity list, choose Activities 
Only.

■ If you want the activity to appear in the calendar as well as the activities list, 
choose Calendar and Activities, and make sure that the activity has a start 
time. 

■ If you want the activity to appear in the My To Do's list on the calendar 
screen, choose To Do and Activities.

The following table describes fields in the Activities form.

Field Comments

Account Displays the account associated with the activity.

Activity # A default value that displays an application-generated 
number.
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Alarm If you want to be reminded of an activity, select the Alarm 
check box. A reminder dialog box appears when the activity 
is due. You can either set an alarm for an individual activity, 
or you can set a default alarm for all your activities. For more 
information, see Fundamentals, MidMarket Edition.

Audience A list of values established by your company that allows you 
to specify which audiences can view the activity. Examples 
of values are employees, partners, and customers.

Billable A check box which when selected, indicates the activity is a 
revenue-generating event.

Category A list of values established by your company that allows you 
to specify a category for the activity. 

Service related activities are often created by one individual 
(such as a call center agent) and completed by another (such 
as a service repair representative). Consequently, when a 
service related category value is selected (such as Diagnostic, 
Field Engineer Activity, Preventative Maintenance or Other), 
the owner of the activity is deleted so that the activity is 
unassigned. The user can then reassign the activity by adding 
a new value to the owner field. If the customer is using Siebel 
Territory Assignment Manager, the activity is automatically 
reassigned. For more information about Activities and 
Categories, see Applications Administration Guide, 
MidMarket Edition.

Comments A text area for notes and information to be shared across the 
team about the activity.

Cost Estimate Displays a monetary value associated with the activity 
estimate.

Created Displays the date and time the activity was created.

Created By Displays the User ID of the activity creator.

Description Enter additional information about the activity in the text 
field.

Display In A field which determines where an activity appears. The field 
has three values— Calendar and Activities, To Do and 
Activities, Activities Only. If, for example, you want an 
activity to appear in your calendar, you must set the Display 
In field to Calendar and Activities.

Field Comments
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Due An editable date field that displays a date and time by which 
the activity must be completed.

Duration A list of values established by your company that allows you 
to choose the duration of an activity. Default values are in 
minute segments, for example 5, 10, 15, and 20.

Employees Displays the User ID of the activity creator. You can select 
multiple employees for an activity, but only one employee 
can be designated as primary.

End An editable date field that displays the proposed date and 
time for the activity completion.

Global Owner Displays the employee who is responsible for the activity.

Meeting Location A text area for location information to be shared across the 
team. Examples of meeting locations are Conference Room B 
and Main Campus Facility.

Opportunity Displays a dialog box that allows you to associate an 
opportunity with an activity.

Owner The field displays the primary employee associated with the 
activity. The default owner is the creator of the activity. Enter 
a new value into the field by typing the User ID directly into 
the field, or click the select button and choose the primary 
employee from the Pick Employee dialog box. In either case, 
the new value replaces the old primary. The new value that 
you enter into the Owner field also replaces the primary 
employee that appears in the Employee field. Conversely, if 
you add a new primary to the Employee field, this new 
primary also appears in the owner field.

Price List A list of values established by your company that allows you 
to specify which price list is associated with a billable 
activity.

Priority A list of values established by your company that allows you 
to assign a priority to the activity. Default values include 1-
ASAP, 2-High, 3-Medium, and 4-Low.

Project Displays a dialog box that allows you to associate a project 
with an activity.

Field Comments
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NOTE: The My To Do filter allows you to view each activity that has been designated 
as a To Do item using the Display In field. Choose My To Do List from the Show 
drop-down list to access this feature. You can further refine your To Do list by using 
the predefined queries that appear in the Queries drop-down list. For example, if 
you select the Uncompleted Activities query, the To Do items that do not have a 
status of Done appear. You can also view uncompleted To Do items in the My To 
Do's list that appears on the calendar screen. This list, by default, only shows To Do 
items that are not yet complete.

Rate List A list of values established by your company that allows you 
to specify which rate list is associated with a billable activity.

Repeat Frequency If Repeat Frequency is selected, this field displays the interval 
at which the activity repeats. Default values include daily, 
weekly, monthly, and yearly.

Repeat Until An editable date field that displays the date and time for the 
last interval of the final meeting in the series.

Site A default value that is automatically entered when you 
associate the account with an activity.

Start An editable date field that displays the date and time the 
activity was created.

Status A list of values established by your company that allows you 
to assign a status to the activity. Default values include 
Acknowledged, Cancelled, Declined, Scheduled, and 
Completed.

Type A required field. A list of values established by your company 
that allows you to define the activity type. Default values 
include Call, Correspondence, and Email.

Field Comments
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Delegating an Activity
If you work as part of a sales team or are a sales manager, you may manage other 
people’s activities. You can delegate an activity to another member of the sales 
team, an employee, or a partner.

To delegate an activity

1 Navigate to the Activities screen.

2 In the Activities list, select the activity that you want to delegate.

3 In the Activity form, click the select button in the Owner field.

4 In the Pick Assigned to dialog box, choose the person to whom the activity will 
be assigned, and then click OK. 

The previous owner is removed from the activity and the newly designated 
person becomes the owner. 

To reassign an activity using the Employee field

1 Navigate to the Activities screen.

2 In the Activities list, select the activity that you want to delegate.

3 In the Activity form, click the select button in the Employees field.

4 In the Employees dialog box, select the individual to whom the activity will be 
assigned.

Click New to add employees to the Employee dialog box.

5 Click the check box in the Primary field to designate the individual as the 
primary employee, and then click OK to close the dialog box.

To remove the old owner from the activity 

1 Navigate to the Activities screen.

2 In the Activities list, select the activity.

3 In the Activity form, click the select button in the Employees field.
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4 In the Employees dialog box, select the old owner and click Delete.

NOTE: If you want the application to use Siebel Territory Assignment Manager to 
automatically assign a person, in the Activity form click the menu button and 
choose Assign. If the delegator uses Siebel Territory Assignment Manager to 
reassign an activity, the delegator is automatically removed from the employee list.

Associating an Employee or Resource with an Activity
When you add an activity to your calendar, you may also want to have a record of 
individuals who participate in the activity, and available resources.

To associate an employee with an activity

1 Navigate to the Activities screen.

2 In the Activities list, select the activity.

3 Click the Participants view tab.

4 In the Employees list, click New.

5 In the Add Employees dialog box, select the employee, and then click OK.

To associate a contact with an activity

1 Navigate to the Activities screen.

2 In the Activities list, select the activity.

3 Click the Participants view tab.

4 In the Contacts list, click New

5 In the Add Contacts dialog box, select the contact, and then click OK.

To associate a resource with an activity

1 Navigate to the Activities screen.

2 In the Activities list, select the activity.

3 Click the Participants view tab.

4 In the Resources list, click New.

5 In the Resources dialog box, select the resource from the list, and then click OK.
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Activity Templates
Activity templates allow you to coordinate complex tasks into a predefined set of 
activities called an Activity Plan. You can select an appropriate Activity Template 
for the goal you want to achieve, which generates a list of activities associated with 
the Activity Template. This keeps you from creating a new list of activities for each 
sales call, corporate visit, and special event. 

For instance, the following list of activities can serve as an Activity Template for a 
a corporate visit with clients for product demonstrations:

■ Book a conference room

■ Set an agenda

■ Confirm the date and time with the customer

■ Make arrangements for presenters

This set of tasks, when defined as a template, helps sales team members follow the 
steps your company recommends to prepare for a corporate visit. The list drives 
critical tasks and defines the recommended lead time for each activity within the 
template.

Activity Plans
Activity Plans are groups of activities or subactivities related to successfully 
completing a business service. Frequently, activity plans incorporate a company’s 
best practices. Using activity plans, you can locate, assign, schedule, and track the 
progress of related activities. 

For example, each activity associated with a customer visit to corporate 
headquarters can be assigned to a different individual, and each activity can have 
a different due date. You can track the progress of all activities associated with the 
customer visit using the Activity Plan.
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Generating an Activity Plan
You can generate an activity plan for an opportunity or for other business 
components including accounts and contacts, and then assign the activities to 
others and set due dates for completion. You can use the following procedure for 
any other business component that has the Activity Plan view tab. 

To generate an activity plan for an opportunity

1 Navigate to the Opportunities screen.

2 In the Opportunities list, select the opportunity.

3 Click the Activity Plans view tab.

4 In the Activity Plans list, click New.

5 In the new activity plan record select a template from the Template field drop-
down list. 

A list of the activities associated with the template you selected appears in the 
Activities subview.
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This chapter explains how to use the Messages screen to create messages and alerts, 
associate them with opportunities and activities, and send messages using email. 
Broadcast Messages is a separately licensed product.
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Messages Overview
The Messages screen provides a way for employees to enter messages into the 
Siebel application and associate messages with accounts, opportunities, contacts, 
and service requests. 

For example, if an employee receives a phone call from a customer asking for more 
information about a product that the employee’s company does not sell, the 
employee can create a message, associate it with the contact, and assign the 
message to a colleague who is knowledgeable about the product. The employee can 
also delegate activities, add attachments, or initiate message alerts.

Business Scenario
An assistant receives a message for an executive, either by phone or by voice mail. 
Instead of writing the message out by hand, the assistant enters the message in the 
Messages screen and assigns the message to the executive. Before saving the 
message, the assistant can perform the following tasks:

■ Associate the message with an existing account, opportunity, contact, or service 
request

■ Add additional information to the message in the Comments field

■ Add electronic file attachments to the message

■ Prioritize the message

■ Send an email or screen alert or both

NOTE: By default, a message is marked private, which means that only the assistant 
and executive can review the message. The assistant can choose not to mark the 
message private, and then any individual with access to the account, activity, 
contact, opportunity, or service request associated with the message can view it.
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Message Communications
You can use messages to communicate with others who also use your Siebel 
application. Messaging allows managers and executives to delegate activities to the 
appropriate employee for follow-up. You can create messages, set up email and 
screen alerts, view and sort messages, and associate activities and other items with 
messages. Using messages allows you to maintain a history of the communication 
associated with a contact, account, opportunity, or information request.

Creating a New Message
Throughout the day, your organization receives phone calls and email. Some of the 
calls or email that you receive may be related to your accounts, contacts, or 
opportunities. By creating messages, you and your colleagues can share knowledge 
and create a history of your interactions.

To create a new message

1 Navigate to the Messages screen.

2 In the Daily Messages list, click New.

3 In the new message form, complete the fields.

The following table describes fields in the Message record.

Field Comments

Account Shows the Account name associated with the message, if 
applicable.

Alert Type Allows you to select a value from the drop-down list to 
indicate the alert type for the message. Default values 
include None, Email, Screen Alert, and Email and Screen 
Alert.

Assigned To A required field that displays the name of the individual 
to whom you are assigning the message. You can select a 
default value in the Default Assigned To field in the User 
Preferences screen. See Fundamentals, MidMarket 
Edition for more information on user preferences.

Comment An optional text field that displays additional 
information.
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Date/Time An editable field that displays the month, day, year and 
the hour, minute, second that the message was created. 

Email Address Automatically populates the email address when you 
select the contact record.

First Name Automatically populates the first name of the contact 
when you select the contact record.

Home Phone # Automatically populates the home telephone number 
when you select the contact record.

Last Name A required field that displays the last name of the contact 
you selected as the message recipient. After a record is 
saved, you can drill down on the hyperlink to navigate to 
Contacts and More Info.

Message A text field that displays the content of the message.

Mobile Phone # Automatically populates the mobile telephone number 
when you select the contact record. 

Opportunity Displays the Opportunity associated with the message, if 
applicable. Click the select button to choose an 
opportunity.

Priority Allows you to select a value from the drop-down list to 
indicate the message priority. Default values include 1-
ASAP, 2-High, 3-Medium, and 4-Low.

Private Displays a check box which, when selected, allows only 
the message creator and recipient to view the message. 
When the check box is cleared, team members associated 
with the opportunity, account, contact, and service 
request can view the message.

SR # Displays the Service Request number associated with the 
message, if applicable.

Status Allows you to select a value from the drop-down list to 
indicate the message status. Default values include New, 
Read, Delegated, Return Call, and Completed.

Work Phone # Automatically populates the business telephone number 
when you select the contact record.

Field Comments
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Message Alerts Overview
There are two types of message alerts you can establish to send screen or email and 
screen alerts. You can set up email and screen alerts for messages and individuals 
to whom you delegate message-related activities, and perform the following tasks:

■ Set up an alert for an individual to whom you routinely send messages

For instance, you routinely send messages to the same individuals, and you want 
to set up a standard alert method to let them know you have sent a message.

■ Set up an alert for a single message so the recipient receives an alert

For instance, you send a message to an individual for whom you have not set up 
a message alert, but you can also set up an alert for the individual message.

Email and Screen Alerts
The following section describes alert types and how they work in your Siebel 
application. You can also select the option of receiving both email alerts and screen 
alerts simultaneously.

A message generates an email alert when the following events occur:

■ A message is created and the Alert Type field has a value of Email or Email and 
Screen Alert.

■ A message is assigned to you, and you have set up an alert to receive email when 
messages or activities are assigned to you by a contact or employee.

■ An activity is assigned to you, and you have set up an alert to receive email 
when messages or activities are assigned to you.

■ You send an email from your Siebel application.

A message generates a screen alert when the following events occur:

■ A message is created and the Alert Type field of the Messages form has a value 
of Screen Alert.

■ A message is assigned to you, and you have set up an alert to receive email when 
messages or activities are assigned to you by a contact or employee.

■ An activity is assigned to you, and you have set up an alert to receive a screen 
alert when messages or activities are assigned to you.
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Setting Up an Ongoing Message Alert
You can set up an ongoing alert type for an individual. This individual always 
receives an alert when you assign a message to him.

To set up an ongoing message alert

1 Navigate to the Messages screen.

2 Click the Message Alert Setup view tab.

3 In the Message Alerts Setup list, click New.

4 In the new Message Alert record, click the select button in the Last Name field.

5 In the Pick Contact dialog box, select the name, and then click OK.

6 In the Alert Type drop-down list, select the type of alert.

The default value in the Alert Type field is None. Other values are Email Alert, 
Screen Alert, and Email and Screen Alert.

Sending a Single Message Alert
You can assign an alert to a single message to notify the recipient of a message. You 
can do this either while you are creating the message or after you have saved the 
message.

To send a single message alert

1 Navigate to the Messages screen.

2 In the Daily Messages list, click New.

3 In the Message Details form, click the Alert Type drop-down list and choose the 
type of alert to assign to the message.
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Viewing Messages
You can view messages assigned to you or created by you in the application.

To view messages assigned to you

1 Navigate to the Messages screen.

2 In the Daily Messages list, select the message to read.

3 Review the Message field in the Message Detail form.

To view messages created by you

1 Navigate to the Messages screen.

2 Click the All Messages view tab.

3 In the All Messages list, click the menu button, and then choose Columns 
Displayed.

4 In the Columns Displayed dialog box, move Created By from the Available 
Columns list to the Selected Columns list, and then click Save.

5 In the All Messages list, click Query, complete the Created By field and click Go.

6 In the All Messages list, sort the messages by Date/Time.

Sorting Messages by Intervals
Use the appropriate view tab to sort messages into Daily, Weekly, or Monthly lists. 
You also can use queries to achieve the same result. The default query for the My 
Messages list displays all messages, but you can select predefined Daily, Weekly, or 
Monthly queries to refine your lists.

To sort messages by intervals

1 Navigate to the Messages screen.

A list of messages you received today appears in the Daily Messages list.

2 Adjust values in the Date fields, and then click Go.

A list of messages for the specified date appears.
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3 Click Today to reset the date to the current date.

4 Click the Weekly Messages view tab to view messages you received in the 
previous seven-day interval.

5 Click the Monthly Messages view tab to view messages you received in the last 
30 days.

Associating a Message with an Opportunity
You can associate a message with an opportunity, a contact, an account, or a service 
request. The following procedure explains how to associate a message with an 
opportunity. You can also use the basic procedure to associate a message with other 
items by selecting the appropriate field name, such as account or contact.

To associate a message with an opportunity

1 Navigate to the Messages screen.

2 In the Messages list, click New.

3 In the Message Details form, click the select button in the Opportunity field.

4 In the Pick Opportunity dialog box, select the opportunity to associate with the 
message, and then click OK.

Associating an Attachment with a Message
You can associate an electronic file as a message attachment to provide you with 
related information. For instance, you can attach a sales document for your 
manager to review.

To associate an attachment with a message

1 Navigate to the Messages screen.

2 Click the Attachments view tab.

3 In the Message Attachments list, click New.
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4 In the new record, click the select button in the Attachment Name field.

a In the Add Attachment dialog box, click Browse.

b In the Choose File dialog box, navigate to the file, and then click Open. 

c In the Add Attachment dialog box, click Add.

The attachment record appears in the Message Attachments list associated with 
the message.

5 In the attachment record, enter a description of the attachment in the Comments 
field.

NOTE: For general information on working with attachments, see Fundamentals, 
MidMarket Edition.

Associating an Activity with a Message
When you need to share information related to an item that requires follow-up 
action, you can associate an activity with a message.

To associate an activity with a message

1 Navigate to the Messages screen.

2 In the Daily Messages list, select the message associated with the activity.

3 Click the Activities view tab.

4 In the Activities list, click New, and then complete the fields for the new record.

NOTE: For more information on the activity-related fields, see Chapter 8, 
“Activities.”
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Sending a Message Using Email
You can send email messages to the recipient from within your Siebel application. 
The recipient either can be inside or outside your corporate firewall because Siebel 
Sales uses the email address associated with the contact information for the 
recipient. After you create a message and fill in the fields, as needed, you can send 
the message as an email.

To send an email message

1 Navigate to the Messages screen.

2 In the Daily Messages list, select the message to send as an email message.

3 From the application level menu, select File > Send > Email.

The Send Email dialog box appears.

4 Complete the fields for the email, and then click Send.

In the email form, click To to display the Address Book dialog box.

NOTE: For information on standard email functionality within Siebel Sales, see 
Fundamentals, MidMarket Edition.
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This chapter explains how sales professionals can use the Correspondence screen 
to communicate and track correspondence with prospects and customers. It also 
explains how to create and use correspondence templates, generating and printing, 
and sending correspondence to a Fulfillment Center. For more information on 
administrative tasks relating to Correspondence, see Applications Administration 
Guide, MidMarket Edition.
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Correspondence Overview 
Correspondence allows you to send direct mail to prospects and customers. 
Correspondence requests are based on templates, which allows users to interact 
consistently in communications.

Correspondence allows you to perform the following tasks:

■ Create new correspondence from a pre-defined or personal template

■ Correspond with one or more contacts using the same template

■ Enclose files and literature with the correspondence

■ Preview and edit your correspondence

■ Deliver correspondence to contacts through several methods

■ Track correspondence you have sent to contacts

NOTE: You can edit correspondence if you have Microsoft Word installed on your 
local computer. You do not need Microsoft Word to create correspondence.
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Business Scenario
Sales professionals use Siebel Sales correspondence to automate letter writing tasks, 
send out literature, and track correspondence sent to prospects and customers. 

A customer requests literature about specific product and service offerings. The 
sales representative creates a letter using a template called Thank You for Your 
Interest. The sales representative selects the contact recipient and determines which 
product literature to include with the letter.

When the sales representative reviews the letter, he see a Microsoft Word document 
that includes the customer’s name and address, thanks the customer for his interest 
and tells him a little about the company. The letter also lets the customer know that 
the sales representative plans to follow up with the customer soon.

When the sales representative is ready to send the letter, he can print the letter and 
send it, or have the company’s fulfillment center generate the letter, enclose the 
product literature, and send it on behalf of the sales representative. The sales 
representative also can email this information to the customer. A record of the 
correspondence is associated with the contact, and allowing the sales representative 
to review the correspondence at a later date.
Version 7.5 Siebel Sales User Guide MidMarket Edition 123



Correspondence

Correspondence Process
Correspondence Process
To create correspondence, use the following process flow.

1 Create a new correspondence record, and specify the appropriate template 
(Required). 

2 Add recipients to the correspondence by selecting one or more contacts 
(Required). 

3 Insert electronic files or enclose literature with the correspondence (Optional). 

4 Generate the Correspondence (Required, if you want to preview the document).

5 Preview the letter (Recommended). 

6 Print, email, or submit the letter to a fulfillment center (Required). 

7 Monitor the fulfillment request to make sure the correspondence has been 
mailed, if you submitted the letter for fulfillment (Recommended). 

Creating Correspondence
You can create correspondence using a selection of pre-defined templates for letters 
and labels. You can create personal templates that only you can access, or you can 
use templates created by your administrator. For information on creating personal 
templates, see “Creating a Personal Correspondence Template.”

NOTE: You must associate one or more recipients with the correspondence before 
you can generate or submit the request for fulfillment.

To create correspondence

1 Navigate to the Correspondence screen.

2 In the Correspondence list, click New.

A new correspondence record appears in the list with In Progress in the Status 
field, and the current date and time in the Created field.
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3 In the new Correspondence record, select a correspondence template.

For example; if you want to create a mailing you might choose the 
MICROSOFT_Promotional template for the letter and the MICROSOFT_Labels 
template for the mailing labels. If you only want to create labels, you still select 
both templates, but only generate the labels with the Generate Labels command 
in the Correspondence list menu.

NOTE: The fixed text of each correspondence template is written using specific 
locale conventions and language. The author of the template can choose the 
locale and language using the Locale and Language fields in the template record 
to support Global Deployment. 

a To create a letter, click select in the Template field, choose a letter template 
from the Pick Template dialog box, and then click OK.

b To create a label, click select in the Template field, choose a label template 
from the Pick Template dialog box, and then click OK.

4 In the correspondence record, complete other fields as needed.

The following table describes fields in the Correspondence record.

Field Comments

Created Date A default value that displays the date and time you created 
the correspondence.

Document Status Displays a system status for the document during 
generation. Default values include In Progress, Generating, 
Completed, and Failed.

Fulfillment Center Displays a drop-down list of fulfillment centers that can 
produce and distribute the document and enclosures on 
your behalf.

Generated Document Drill down on the hyperlink in this field to preview the 
document merged with the name and address of the selected 
recipient in the Recipients list.
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5 Click in the Recipients list and proceed to “Editing a Template.”

NOTE: You can create correspondence from any screen by navigating to the 
application-level menu and selecting File > New > Correspondence. This action 
takes you to the Correspondence screen where you can create your letter or label.

Generated Label Drill down on the hyperlink in this field to preview the label 
merged with the name and address of the selected recipient 
in the Recipients list.

Label Status Displays a system status for the label during generation. 
Default values include In Progress, Generating, Completed, 
and Failed.

Label Template Displays the name of the label template defined by your 
company and created by your Siebel administrator, or your 
personal template.

Modified Template If you have modified the template, click the select button in 
this field and navigate to the modified file to choose it. For 
example, you choose a template, drill down on the Template 
name hyperlink to open the template and modify template 
text. After saving the modified file locally, you specify it 
using the Modified Template field.

Opportunity Displays the name of the opportunity associated with the 
correspondence. Drill down on the opportunity name 
hyperlink to open the Opportunity details form.

Status Displays a status for the correspondence. Values include 
Submitted, Pending and Completed.

Template Displays the name of the selected template defined by your 
company, or your personal template.

Field Comments
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Editing a Template
You can edit an existing template to add a different personal message to each 
Correspondence request. By editing the template you only modify the template for 
the selected Correspondence request. Only an Administrator can make a global 
change to a template.

To open and edit an existing template

1 Navigate to the Correspondence screen.

2 In the Correspondence list, click New.

3 In the new correspondence record, click the select button in the Template field. 

4 In the Pick Template dialog box, choose a template, and then click OK.

The template name appears in the field.

5 Drill down on the hyperlink in the Template field to open it in Microsoft Word.

6 In Microsoft Word edit the template, and then select Save As to save the edited 
template to your desktop or to a shared network folder.

7 In the Correspondence record, click select in the Modified Template field to 
browse and add your edited template to the Correspondence record.

Inserting Templates into Correspondence Templates
You can insert one or more templates into your correspondence template. For 
instance, if you have a description of your company that you want to include in 
many correspondence templates, you can type this description in a separate file and 
insert the text into the correspondence you send. You can insert as many files into 
a correspondence item as you want, but each file name must be unique. 

Your Siebel application supports inserting one level of files, but you cannot insert 
nested files. For instance, you can insert files called File1.doc, File2.doc, and 
File3.doc into a template called FollowUp.doc, but you cannot insert File1.doc into 
File2.doc and then insert File2.doc into FollowUp.doc. Each file must be inserted 
into the correspondence template independently. 

The template into which you insert the file can be a public template created by an 
administrator, or a personal template that you created. Only Microsoft Word files 
can be inserted into Microsoft Office templates.
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To insert a file into a correspondence template

1 Create a correspondence record.

For more information, see “To create correspondence” on page 124.

2 In the Template Name field, choose the file that you want to insert.

3 Use Microsoft Word to edit the correspondence template in which you want the 
file to be inserted.

Drill down on the hyperlink in the Template field to open the template in 
Microsoft Word.

4 Within the template file, locate a separate line at the location where the file 
should be inserted, and then enter the following text where [[<File Name>]] 
is the name of the inserted file.

[[<File Name>]]

NOTE: The file name must have the same name as the template into which it is 
inserted. 

5 Save the modified template to your desktop or on a shared network drive.

6 In the Modified Template field, select the modified template.

7 Click Generate.

When you generate the correspondence, the file is merged into the 
correspondence.
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Adding a Recipient
You must add or select one or more contacts as recipients before you can generate 
correspondence. If you are sending correspondence to someone who is not listed as 
a contact, you can add that individual in the Add Recipients dialog box. The 
individual is then added to the Contacts list and as a recipient for the selected 
Correspondence record.

NOTE: There is no maximum limit to the number of recipients that you can add to a 
correspondence item, however, the number of recipients affects performance and 
time required to generate the final document.

To add a recipient to correspondence

1 Complete the procedure for “To create correspondence” on page 124.

2 In the Recipients list, click Add.

3 From the Add Recipients dialog box, add recipients.

Use one of the following methods:

■ To send correspondence to an existing contact, elect the recipient in the Add 
Recipients dialog box, and then click Add.

■ To send correspondence to a new contact, click New in the Add Recipients 
dialog box, complete the fields as needed, and from the menu, choose Save.

NOTE: You can drill down on the hyperlink in the Last Name field to navigate 
to the Contacts screen’s Activities list.
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Enclosing Literature with Correspondence
You can select literature such as sales brochures, white papers, and data sheets from 
the Siebel Encyclopedia and associate the information with your correspondence. 
This functionality allows you to send and track items you enclose with 
correspondence. 

To view available literature

1 Navigate to the Correspondence screen.

2 From the Show drop-down list, choose Literature Selection.

3 In the Explorer tree, click the plus sign (+) to expand the view of literature items 
in each category.

The list at right provides detail for selected category items.

4 In the list, use Query to locate desired literature items. 

NOTE: In the Explorer, when you drill down to the actual Literature item, the Add 
Enclosure button appears on the Literature list at right. Add Enclosure allows 
you to add the enclosure to the correspondence record. However, most users 
select the enclosure using the Enclosures list on the Correspondence screen.

To enclose literature with correspondence

1 In the Correspondence list, create a correspondence record.

For more information, see “To create correspondence” on page 124.

2 In the Enclosures subview list, click Add.

3 In the Add Literature dialog box, select the literature item you want to enclose 
and then click Add.

4 In the Enclosures list, complete the fields for the enclosure.
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5 To view the literature file, drill down on the hyperlink in the Name field. 

You must have the corresponding application loaded on your computer to view 
literature files created using that application.

NOTE: If you are working in a disconnected environment (remote), you must 
have the literature files available in your local environment. If the Local check 
box is selected, you can work with the file in a remote environment. To 
download the file from the server the next time you synchronize, select the 
Request checkbox when you add the Literature file.

Generating Correspondence
After you have created a correspondence item from a template, selected or added 
recipients, you can generate your correspondence. The Generate button is disabled 
after a correspondence is queued.

NOTE: You cannot edit and regenerate a document that has already been generated. 
Instead, specify modified document templates in the Modified Template field.

To generate correspondence

If you are creating correspondence in a connected environment (network), you can 
follow Step 1 through Step 4.

If you are creating correspondence in a disconnected environment (remote) and 
have the Siebel Web Client installed locally on your computer, you can follow Step 1 
through Step 3.

1 In the Correspondence list, create a correspondence record.

For more information, see “To create correspondence” on page 124.

2 Associate a recipient with the correspondence record.

For more information, see “To add a recipient to correspondence” on page 129.
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3 In the Correspondence list, select the letter, and then click Generate.

A draft of the letter appears if you are in a disconnected environment.

4 Click Update to generate correspondence from the server if you are working in 
a connected network environment.

The status of the correspondence refreshes when you click Update. 
Correspondence Status values include In Progress, Generating, Completed, and 
Failed.

If the status is Failed, an error message appears in the Document Error or Label 
Error fields.

Previewing Letters and Labels
You should preview the letter before sending it to a contact. If you do not use a 
fulfillment center, you can print a letter or label from the preview screen. You must 
generate correspondence before you can preview it.

NOTE: If you use a fulfillment center, you do not have to print the letter, but you 
should still preview it before sending it. 

To preview a letter or label

1 Navigate to the Correspondence screen.

2 In the Correspondence list, select the correspondence you want to preview.

■ Drill down on the Merged hyperlink in the Generated Document field to 
display a document in your word processor, if you have the word processor 
installed locally. 

■ Drill down on the Merged in the Generated Label field to display labels in 
your word processor, if you have the word processor installed locally. 

■ In the Correspondence list, click the menu button and choose View (HTML) 
to display a document in your Web browser if you do not have the word 
processor installed locally. 
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■ In the Correspondence list, click the menu button and choose View Label 
(HTML) to display labels in your Web browser if you do not have the word 
processor installed locally. 

The letter or label appears, with the recipient’s name and address information 
merged into the template.

Sending Correspondence to a Fulfillment Center
If the fulfillment center is part of the Siebel Enterprise, you can submit fulfillment 
requests from the Correspondence list. 

To send correspondence to a fulfillment center

1 Navigate to the Correspondence screen, and from the Show drop-down list 
choose My Correspondence Requests.

2 In the Correspondence list, select the correspondence that you want to submit 
to your fulfillment organization. 

3 In the Correspondence list, click the Fulfillment Center drop-down list and then 
select the appropriate fulfillment center.

4 Click Submit.

The Document Status changes to In Queue.

Monitoring Fulfillment Requests
When you submit correspondence to a fulfillment center, its status is set to 
Submitted. When your correspondence request is fulfilled, the fulfillment center 
updates the status to Done, which associates an activity with each recipient 
(contact). You can monitor the status to determine the date and time that your 
correspondence was sent and time your follow-up calls and sales visits accordingly.

To monitor fulfillment requests

1 Navigate to the Correspondence screen.

2 In the Correspondence list, select the correspondence record, and then verify 
that Done appears in the Status field.
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Recalling Correspondence
You can recall correspondence records that you have submitted, as long as they 
have not been fulfilled. You can recall correspondence to modify it and re-submit it 
for fulfillment.

To recall correspondence

1 Navigate to the Correspondence screen.

2 In the Correspondence list, select the correspondence to recall.

3 Click the menu button, and then choose Recall.

The correspondence status reverts from Submitted to In Progress. 

Creating a Personal Correspondence Template
You can create your own letter templates that are not accessible to other users. 
Although you can create a template from scratch, it is much easier to create a 
template based on an existing correspondence template. This approach allows you 
to reuse elements from the existing template, such as a company logo or mail merge 
fields, in your personal template.

You must have Microsoft Word installed locally to create a personal template. 

NOTE: Mail merge fields are placeholders for information that is merged from your 
Siebel application into correspondence. Creating mail merge fields from scratch (not 
copied from a template) is a complex process that requires the assistance of your 
Siebel administrator. 

To create a personal template

1 Navigate to the Correspondence screen.

2 From the Show drop-down list, choose Personal Templates.

3 In the Personal Templates list, click New.

4 In the new record, click the select button in the Template Name field.

The Add Attachments dialog box appears.
134 Siebel Sales User Guide MidMarket Edition Version 7.5



Correspondence

Correspondence Process
5 In the File Name field, click Browse.

6 In the Choose File dialog box, select the document and then click Open.

7 In the Add Attachment dialog box, click Add.

The template name appears in the File Name field, and the Active, Size, Type 
and Modified fields are populated with information about the file.

This template appears in your list of templates.

8 In the Templates list, drill down on the file name hyperlink to view the template.
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Batch Printing
To batch print, you select correspondence items and then click the menu button and 
choose Print. The Print menu item is only active if the selected correspondence 
record has a value of Completed in the Document Status column.

The Print menu item in the Correspondence and Fulfillment screens is configured 
for client-based printing. However, your administrator can configure server-based 
printing in addition to (or instead of) client-based printing.

Check with your system administrator to determine which print method is 
available.

Using Client-Based Batch Printing
When you use client-based batch printing, the Siebel application launches 
Microsoft Word on your client system. The application retrieves the document from 
the Siebel File System and prints it to the default printer configured for your desktop 
session. To use this feature, verify that the following prerequisites have been met:

■ Microsoft Word must be installed on the client system.

■ Internet Explorer must be configured to start Microsoft Word.

■ The default printer must be configured for your desktop.

To configure Internet Explorer to allow client-based batch printing

1 Start Internet Explorer and log on to the Siebel Sales application.

2 In the Internet Explorer, select Tools > Internet Options.

3 Select the Security tab. 

The security zone used by Siebel is highlighted (either Local intranet, or 
Trusted). Verify that any other URL in this zone can be trusted with extra 
security privileges.

4 Select Custom Level.

5 In the Security Settings dialog box, find the option Initialize and script ActiveX 
controls not marked safe. Change the setting to either Enable or Prompt.
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6 Click OK, and then click Yes to answer the question Are you sure you want to 
change the security for this zone?

7 In the Internet Options dialog box, click OK.

To add a printer connection to your desktop

1 Select Start Menu > Settings > Printers.

2 Double-click the Add Printer icon.

3 Click Next on the Welcome screen.

4 In the Local or Network Printer screen, select Network Printer, and then click 
Next.

5 In the Locate Your Printer screen, select Type the Printer Name and either type 
the network name of the printer, or click Browse and select the printer.

6 Click Next.

7 In the Default Printer screen, choose either Yes, or No, and then click Next.

8 In the Completing the Add Printer Wizard screen, click Finish.

To change the default printer

1 Select Start Menu > Settings > Printers.

The current default printer is marked with a check mark.

2 Select a new default printer by right clicking on the desired printer and choosing 
Set as Default.

To print documents using client-based printing

1 Close open files in Microsoft Word.

2 From the Siebel Sales application-level menu, choose View > Site Map > 
Correspondence or Fulfillment.

3 In the Correspondence list, select one or more records.

Each selected correspondence record must have a Document Status of 
Completed.
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4 In the Correspondence list, click the menu button, and then select Print.

The selected documents are printed to the configured default printer.

Using Server-Based Batch Printing
Server-based batch printing sends a printing request to the Siebel Document Server. 
The document is then sent to the printer specified in User Preferences. If you do not 
specify a printer, the document is printed on the default printer configured by the 
System Administrator.

To specify a printer for server-based batch printing

1 From the application-level menu, choose View > Site Map > User Preference 
> Correspondence.

2 In the Default Printer field, enter the network name of the printer used for 
Correspondence. 

The network name should contain both the printer server name and the printer 
name as shown in the following example.

\\printer_server_name\printer_name

3 In the Printer Driver field, enter the name of the printer driver used to generate 
an intermediate file during the printing process, and then click Save.

The System Administrator should provide you with a list of printer drivers and 
their associated printer types. Select the Printer Driver associated with the 
printer you previously specified in Step 2.

To print documents using server-based printing

1 From the application-level menu, choose View > Site Map > Correspondence 
or Fulfillment.

2 Select one or more records in the Correspondence list. 

Selected correspondence must have a Document Status of Completed.

3 In the Correspondence list. click the menu button and then select Print.

The selected documents are printed to the default printer specified in User 
Preferences.
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This chapter explains how to use the Literature screen and associated views to 
distribute documents, white papers, marketing brochures, and other forms of 
literature by email or fax.
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Literature Overview
You can use literature to view and distribute white papers, marketing brochures, 
competitive data, product information, and other types of documents that your 
company determines are appropriate for the literature repository.

Literature is stored and managed online, which allows you to view the most recent 
versions through the shared repository. Typically, content experts at your company 
maintain the literature repository by updating files, adding new ones, and removing 
outdated ones.

Business Scenario
A sales representative reviews sales and marketing information stored in the 
literature repository. The sales representative’s company sells a large number of 
products, and literature allows the representative to view and distribute sales 
brochures, white papers, and other product information.

A customer calls to ask the sales representative for specific information on a new 
computer hardware component that the representative’s company recently 
advertised. The sales representative can use literature to research the hardware 
specifications and features while the customer is on the telephone. The 
representative can also email or fax product literature to the customer while the 
customer and representative are viewing the literature online.
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Working with Literature
Literature can be associated with a product, an account, or a competitor. You use 
the Literature screen to perform the following tasks:

■ View a list of available marketing and sales information

■ Display a document in the application in which it was created

■ View and print a document.

■ Send a document by email or fax

Viewing Literature

To view literature

1 Navigate to the Literature screen.

2 In the Literature list, select the literature item you want to view.

3 Drill down on the Name hyperlink.

The application that was used to save the document opens, and the document 
appears.

Sending Literature by Email or Fax
You can send a literature item as an email attachment or a fax message from within 
your Siebel application. 

To send literature

1 Navigate to the Literature screen.

2 In the Literature list, select the literature item you want to send.

3 To send the literature as an email, select File > Send > Email from the 
application-level menu.

The Send Email dialog box appears with the literature item added as an 
attachment.
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4 To send the literature as a fax, select File > Send > Fax from the application-
level menu.

The Send Fax dialog box appears with the literature item added as an 
attachment.

5 In the dialog box, fill in the fields as needed and then click Send.

NOTE: You can attach additional files to the email by clicking the attachment icon 
and following the procedure to attach a file. For more information on 
attachments, see Fundamentals, MidMarket Edition.

Viewing Product Literature
The Product Literature Explorer allows you to navigate through your company’s 
product lines and services and view individual literature items.

NOTE: You can also use the InfoCenter Explorer to find product information and 
other types of literature.

To view product literature

1 Navigate to the Literature screen.

2 From the Show drop-down list, choose Product Literature.

The Product Literature Explorer appears.

3 In the Product Lines Explorer list, select the product line, and then click the plus 
sign (+) next to each folder in the hierarchy of folders until you reach the 
Literature folder.

Clicking the plus (+) sign next to the Literature folder displays a list of literature 
items associated with the product. The list appears to the right of the explorer.

4 In the Literature list, drill down on the Title hyperlink.

The literature item opens in the format in which it was saved.
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This chapter explains how sales professionals can use the Categories screen and 
associated views to track information about accounts, opportunities, and contacts.

Categories Overview
Categories allow you to track information about accounts, opportunities, and 
contacts using categories you define. Later, you can use these categories to sort and 
search for specific criteria. Using categories, you can enter information that is 
important to your personal sales approach and style. You can share this information 
with the sales team, or keep it private.
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Business Scenario
A sales representative wants to track information to help manage relationships with 
current and potential customers. Categories provide the sales representative with a 
way to store additional information about an account, opportunity, or contact. 
Either the sales representative can designate categories as private, or she can share 
them across a sales team.

The sales representative can track the most active accounts by creating a category 
called Hot Accounts and selecting that category for each account that she wants to 
add to her active list. 

The sales representative also can view a list of all the opportunities she has closed 
over a period of time. If she sets up a Closed category, she can see which 
opportunities she has closed during the previous year. 

Sales professionals can use categories to track personal information about contacts. 
For instance, a sales representative can record hobbies, such as golf or tennis, and 
designate that category for contacts she plans to invite to her company-sponsored 
sporting events. In addition, she can track family names or add contacts to a 
category called Holiday List that allows her to create a mailing list.
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Using Categories
You can use account categories to define and track sorting criteria for your personal 
use or to share across your sales team. Your company can define business processes 
to determine what categories mean and how to associate value with them.

Adding an Account Category
You can add categories to accounts, contacts, and opportunities. 

To add an account category

1 Navigate to the Accounts screen.

2 In the Accounts list, select the account for which you want to add a category.

3 Click the Categories view tab.

The Account details form appears with the Categories list.

4 In the Categories list, click New.

5 In the new record, click the select button in the Category field.

6 In the Pick Category dialog box, choose an existing category, or click Query to 
locate a category, and then click OK.

NOTE: In the Pick Category dialog box, click New to create a new category, and 
then complete the category name, description, and public fields to add the new 
category to the Pick Category dialog box.

7 Complete the category fields, as needed.

The following table describes fields in the Category record.

Field Comments

Category Displays a dialog box that allows you to select an existing 
category or add a new one.

Category Rank Displays value that allows you to further define the category. 
The rank can be any numeric value. 
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NOTE: You can add a Contact or Opportunity category using the same procedure. 
Navigating to the appropriate screen and then follow Step 3 through Step 7 in 
the procedure.

Searching for an Account Category
You can search for specific accounts, opportunities, and contacts using the 
categories you and your team have defined. 

To search for an account category

1 Navigate to the Categories screen.

2 In the Categories list, click Query. 

3 In the Category form, click the select button in the Category field.

4 In the Pick Catalog dialog box, choose a category, and then click OK.

5 In the Categories query form, click Go.

A list of accounts with the selected category appear in the Categories list.

NOTE: Follow the same procedure for the Opportunities, Contacts, and Personal 
Categories. Change the Show filter to search for the appropriate category.

Comments A text field that displays additional information.

Private A check box which, when selected, restricts sales team 
members from seeing how you have categorized the account. 
When the check box is selected, the category is private.

Clear the check box to designate the category as Public 
allowing access by team members.

Value Displays a numeric value that allows you to assign a value to 
the category.

Value Rank Displays a numeric value that allows you to assign a rank to 
the value.

Field Comments
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This chapter explains how to use the Quotes screen and associated views to create 
quotes, add line items and details, apply manual discounts, and generate sales 
orders. 

Quotes Overview
When a customer is ready to purchase a product or service, you provide the 
customer with a quote for the total cost. A quote is a formal offer for products and 
services provided to a prospective customer that includes specific prices and related 
payment terms. Your Siebel application allows you to accurately create a quote for 
a customer and deliver it promptly.

Business Scenario
A sales representative uses quotes to create formal offers to prospects for a variety 
of products and services his company provides. Siebel Sales helps the sales 
representative develop accurate quotes without being encumbered by manual 
verification. The sales representative can access information and resources in one 
central location, which eliminates the need to cross reference pricing books, and he 
can create a quote record and add line items to configure a specific quote. You can 
also create a package of line items.
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Quotes include effective dates, price lists, and discounts used in pricing products 
and services. Before you can work with the line items and details of a quote, you 
must create a quote, which can be associated with an opportunity. 

NOTE: Quotes also can be created from the Quotes screen, the Accounts screen, or 
the Contacts screen. The following procedure discusses creating quotes from the 
Opportunities screen.

Creating a Quote
Use the following procedure to create a quote, using the Opportunities screen. 
Quotes can also be created by navigating directly to the Quotes screen.

To create a quote

1 Navigate to the Opportunities screen.

2 In the Opportunities list, select the opportunity, and then click the Quotes view 
tab.

3 In the Quotes list, click New, and complete the fields for the record.

Siebel Sales copies the account or opportunity information into the quote. If a 
price list is associated with the account or opportunity, it is also entered. Your 
name automatically appears as the Sales Rep. In addition, values are 
automatically generated for the following fields on the More Info form. 

The following table describes the fields in the Quote record that must be 
completed.

Field Comments

Active A check box indicating whether the quote is active. When you 
create a quote, it is automatically marked as active.

The quote must be designated as active before it can be updated or 
files can be attached to it.
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4 If account information was not automatically entered into the quote, enter the 
account name.

5 Enter a name for the quote. 

If you do not enter a name for the quote, the quote number is automatically 
assigned as the name.

6 In the Price List field, click the select button to select a price list for the quote, 
if one is not assigned automatically through association with the account.

7 Click the show more button if you want to apply a Discount to the line items you 
add to the quote.

The discount you enter in this field is used instead of any pricing rules 
associated with a price list. 

Created The date the quote was created. Siebel Sales automatically sets the 
value for an active quote to the Effective As Of (Start Date) + 30 
days. 

Currency Defaults to the currency associated with the price list.

Effective As Of Defaults to the created date. You can change this date, if necessary.

Effective 
Through

Defaults to the effective date plus 30 days. You can change this date 
if the quote is effective for a different length of time.

Name Defaults to the unique number assigned to the quote at creation. 

Quote # This unique system-generated number is assigned to the quote at 
creation.

Revision The number of revisions associated with the quote. At quote 
creation, this value = 1.

Status The default status is In Progress. You can change the status as the 
quote advances. Examples of status are Approved, Rejected, 
Expired, Order Placed, and Active.

Field Comments
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Using Auto Quote 
If you are working with an opportunity for which the products and solutions have 
already been specified, there is a faster method to generate a quote. You can use the 
Auto Quote button.

NOTE: Only products with the Auto Quote flag set are available using Auto Quote. 
The Auto Quote (check box) flag for products is set in the Opportunity screen’s 
Products view.

To use Auto Quote

1 Navigate to the Opportunities screen.

2 In the Opportunities list, select the opportunity associated with the quote, and 
then click the Quotes view tab.

3 In the Quotes list, click Auto Quote.

A new quote record appears with some fields automatically populated. For more 
information, see “To create a quote” on page 148.

4 Enter a name for the quote in the Name field, and then select the appropriate 
price list in the Price List field.

5 In the Status field, click the select button to choose a valid status.

6 (Optional.) Drill down on the quote name to display the Quote Line Items view, 
where you can perform further work with the quote.

You can update opportunities with information from a quote. For more 
information, see “To update quote information to the opportunity” on page 161.

NOTE: You can create quotes in the Opportunities screen’s Quotes view, the 
Accounts screen’s Quotes view, or the Quotes screen.
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Line Items and Details
Drilling down on the quote name in the Quote screen’s Quote list allows you to add 
line items and additional quote details and information.

NOTE: You cannot query for packaged products in Quotes screen’s Line Items view. 

Adding Line Items
Products associated with quotes in the Opportunity screen’s Products view appear 
automatically as line items with any applicable discounts if you use Auto Quote to 
create the quote.

Using Line Items, you can perform the following tasks:

■ Add new products to a quote as Line Items

■ Reprice using the most current price list and automatic price adjustments using 
the menu button’s Reprice command

■ Save combinations of packaged items

■ Associate services with the quoted products

■ Apply manual price adjustments to the Line Items

To add a line item

1 Navigate to the Opportunities screen.

2 In the Opportunities list, select the opportunity with which the quote is 
associated.

3 Click the Quotes view tab.

4 In the Quotes list, select the quote, and then drill down on the Name hyperlink.

The Line Items list and the Totals subview appear.

5 In the Line Items list, click the menu button, and then click New Record.
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6 In the Line Items list, click the select button in the Product field and choose a 
product from the Pick Product dialog box.

NOTE: To enter more than one line item, repeat Step 5 through Step 6 for each 
item. 

The following table describes the fields that are automatically generated for the 
Line Item record.

Field Comments

Attributes A text description or abstract of the product offering.

Extended Net Price If the quantity reflects a number of products for the line 
item, then the extended net price reflects the total for the 
number of products listed.

Extended Qty Displays a default value of 1. Reflects the actual number of 
units contained in the component product, packages, or 
bundle that is ordered. This field differs from the Qty field 
for hierarchical products.

Item Net Price The price for an individual item. When you are referencing 
component products or packages, the Item Net price is the 
net price of the top level only and does not include the 
rollup.

Part # A unique number assigned to the product you selected.

Qty Displays a default value of 1. You can edit this field to 
reflect the number of products associated with the line 
item. Reflects the actual number of units of a component 
product, package, or bundle that is ordered.

Start Price The undiscounted price for an individual item from the 
price list associated with the quote.

Unit Net Price Net price of the item and the rollup of the unit net price of 
its immediate children. The net price and unit net price for 
simple products are the same.
152 Siebel Sales User Guide MidMarket Edition Version 7.5



Quotes

Line Items and Details
To update the prices and totals for your line items

1 In the Line Items list, click the menu button, and then choose Reprice to 
manually reprice a single line item. 

It is not necessary to routinely use Reprice and Reprice All after adding line 
items. 

2 In the Line Items list, click the menu button, and then choose Reprice All to 
reprice all line items.

Using Browse Catalog to Add Line Items
An alternative way to add line items to a quote is by using the Browse Catalog 
feature, which takes you to the Product catalog. In the Product catalog you can add 
additional products or services to the customer’s existing quote.

NOTE: The Browse Catalog feature is only available to you if your company has 
purchased Siebel eSales, MidMarket edition. For more information, see Siebel eSales 
Administration Guide, MidMarket Edition.

After you finish adding the additional products and services, click View Quotes to 
update the information.

You also have the ability to add line items manually without using the Browse 
Catalog feature.

To use Browse Catalog to add Line Items

1 Navigate to the Opportunities screen.

2 In the Opportunities list, select the opportunity associated with the additional 
quote information.

3 Click the Quotes view tab.

4 In the Quotes list, select the quote, and then drill down on the hyperlink in the 
Name field.

5 In the Quote form, click Browse Catalog.
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6 In the Catalog’s Browse list, select each product to add by supplying the quantity 
and clicking Add to Cart.

7 After the desired products have been added, click View Details in the Catalog 
view to return to the Line Items list.

Using Add Items to Add Line Items
Use the Add Items feature to add multiple items, and specify the quantity and 
attributes for those items.

To add a product to a quote using Add Items

1 Navigate to the quote to which you want to add items.

2 Drill down on the quote name to display the Line Items list.

3 In the Line Items list, click Add Items.

4 In the Pick Products dialog box, select the products to add to the quote.

a In the Order Qty field, enter the quantity for each product, and then click Add 
or press the tab key.

b To specify attributes for a product, click Attributes, complete the dialog box, 
and then click OK.

c When you are finished specifying product quantity and attributes, click OK.

The products appear in the Line Items list.

Adding Items One at a Time
If you want to add products one at a time to the Line Item list, and you already know 
the product name, you can use the New Record command accessed by clicking the 
menu button.

To add items one at a time

1 Navigate to the quote to which you want to add items.

2 Drill down on the quote name hyperlink to display the Line Items list.
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3 In the Line Items list, click the menu button, and then choose New Record.

4 In the Line Items list, enter the product name in the Product field.

5 (Optional) Make any necessary changes to the quantity or attributes.

6 (Optional) Enter discounts and price adjustments. 

Using Templates to Add Line Items
Product selection templates are groups of products and attributes that have been 
saved for reuse. Some product selection templates are public, and available to 
anyone using the Siebel application. Other product selection templates are private, 
and are available only to you. Private templates are those you create from an 
existing quote or order.

To add all the items in a template to the current quote

1 Navigate to the quote to which you want to add items.

2 In the Quote header summary, click Select Template.

3 In the Product Selection Template dialog box, select the template and click OK.

The items and associated attributes are copied into the quote or order.

4 Make any additional changes you want to the line items.

To add some of the items in a template to the current quote or order

1 Navigate to the quote to which you want to add items.

2 In the Quote summary form, click Select Template.

3 In the Product Selection Template dialog box, drill down on the name of the 
template from which you want to select items.

The Product Template List appears, and the Product Template Item List shows 
all the products in the template.

4 Select the products you want to add to the current quote, and then click Add 
Selected Items.

The quote or order screen appear, and the items you selected appear in the Line 
Items list.
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Adding a Package of Line Items
In the Line Items list you can create a product bundle called a package. The package 
unit net price is the rolled up price of its bundled component products. If you 
discount the price of a component product or change the quantity of a component 
product, the price difference is automatically reflected in the unit net price and the 
extended price for the package. After you a package to a quote, you can add 
individual product items to the package and renumber the items.

To add a package of Line Items 

1 Navigate to the Quotes screen.

2 In the Quotes list, locate the name of the quote to which you want to add a 
package of products, and then drill down on the Name hyperlink.

3 In the Line Items list, click the menu button, and then click New Record.

4 In the line item record click the select button in the Product field.

5 In the Pick Product dialog box, type Package, and then select the package 
product.

6 In the Line Items list, click the menu button, and then select Save Record.

To add a product to a package of line items

1 Select the package item, click the menu button, and then choose New Record.

A new line item row appears.

2 In the line item row, add the first product from the Product list to the package 
you created.

3 Follow the procedure for “To add a line item” on page 151.

4 (Optional) Modify quantities and discounts for products in the package.

5 Select the new product line item, and then click the Indent button.

The icon and number in the Sequence column change to reflect the addition of 
a product line item to the package.

The Outdent button removes products from packages.

6 To add more than one product to a package, repeat Step 1 through Step 5 for 
each item. 
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Line Item Details
For each line item in a quote, the Line Item Detail form allows you to view and 
modify data. Using Line Item Details, you can apply a manual discount to a line 
item. After you have priced all line items in a quote, you can view the total of all 
discounts applied to each line item by clicking the Totals subview tab.

Adding a Write-In Product
You can create a write-in product for items not included in the price list.

When a product is not listed in the price list and you need to add the information 
manually, you create a write-in product.

To add a write-in product

1 Navigate to the Quotes screen.

2 In the Quotes list, select the quote, and then drill down on the hyperlink in the 
Name field.

3 In the Line Items list, click the menu button, and then click New Record. 

a In the Product field, click the select button.

The Pick Product dialog box appears.

b In the Product field, type *Write* and then click Go.

c In the Pick Product dialog box, select Write-In Product and then click OK.

The Part # and Qty fields are automatically populated.

4 In the Line Items list, click the menu button, and then click Save Record.

5 Click the Line Item Detail view tab.

6 In the Line Item Detail form, complete the Disc Price field.

7 Select the Keep Discount check box.

8 In the Line Item Detail form, click the menu button, and then click Save Record.

NOTE: The Keep Discount check box allows you to override pricing rules.
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Applying a Manual Discount
You can apply a manual discount to an entire quote or to any line item in a quote. 
If you apply a manual discount (a percentage) to an entire quote, the discount 
percentage applies to each line item, and the result is reflected in the price for the 
entire quote. 

If you enter a manual discount for a line item and select Keep Discount flag, your 
item manual discount overrides the quote level discount for that line item. Manual 
price adjustments and automatic (system-applied) price adjustments function 
independently. The Keep Discount flag determines whether the line item or the 
automatic discount applies.

To avoid automatically overwriting a manual discount the next time you click 
Reprice or Reprice All, make sure the Keep Discount check box is selected.

To apply a manual discount to an entire quote

1 Navigate to the Opportunities screen.

2 In the Opportunities list, select the opportunity with which the quote is 
associated.

3 Click the Quotes view tab.

4 In the Quotes list, drill down on the hyperlink in the Name field.

The Quote form appears, showing header data for the quote.

5 In the Discount field of the Quote form, select the discount (a percentage value) 
that you want to apply to the existing quote. 

The percentage discount is applied to each line item, and the Keep Discount 
check box is selected for each line item. Selecting the keep discount option 
prevents further modifying of the price after the manual discount has been 
applied.

To apply a manual discount to a line item in a quote

1 Navigate to the Opportunities screen.

2 In the Opportunities list, select the opportunity with which the quote is 
associated.
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3 Click the Quotes view tab.

4 In the Quotes list, drill down on the Name hyperlink.

The Quote form appears, showing header data for the quote.

5 Click the Line Items view tab.

6 In the Line Items list, select the line item that you want to manually discount. 

Discount information for the selected line item appear in the Line Items Detail 
form.

■ Discount Amount indicates the amount of any applied discount resulting 
from (automatic/non-manual) adjustments. 

■ Percentage Discount indicates the percentage discount for the line item. 

The Keep Discount check box is not automatically selected. The check box is 
selected when discounts are applied using the Quote header.

NOTE: Manual discounts applied to the entire quote do not appear in the line 
item discount fields, but they are reflected in the net price field and the Net Disc 
% field for the line item.

7 In the Line Items Detail form, enter the discount or override price that you want 
to apply to the selected line item.

■ To enter a discount percentage, use the Disc % field. This overrides other 
discounts.

■ To enter a discount amount, use the Disc Amount field. This subtracts the 
dollar amount from the starting price.

■ To enter a new price that overrides any other discounts, enter the amount in 
the Disc Price field. Use this field whenever you want the discount to be the 
final price.

The Discount percentage or the Discount Price you entered is applied to the line 
item. 
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Renumbering Line Items
After you have added all the line items for a quote, you can change the sequence of 
the items. Items appear in numbered sequence for orders and reports, and you may 
want to renumber them using a sequence that makes sense to your prospect.

To renumber line items

1 Navigate to the Quotes screen.

2 In the Quotes list, drill down on the Name hyperlink of the quote you want to 
renumber.

3 In the Line Items list, navigate through the columns until you see the Line field.

4 In the Line field for each item, renumber as desired.

5 Click the up or down arrow on the Line field to sort the line numbers in 
ascending or descending order.

This action re-sorts the list based on the numbers you assigned in Step 4. 
Clicking the menu and choosing Renumber only generates sequential integer 
numbers so that your items now appear neatly sequenced. 

6 In the Line Item List, click the menu button, and then click Renumber.

The line items appear in the updated sequence, as shown in the following figure.

7 In the Line Item List, click the menu button, and then click Save Record.
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Deleting Line Items
Use the following procedure to remove line items from your quote.

To delete line items

1 Navigate to the Quotes screen.

2 In the Quotes list, select the quote for which you want to delete the line item.

3 In the Quotes list, drill down on the hyperlink in the Name field.

4 In the Line Items List, select the item, click the menu button, and then choose 
Delete Record. 

5 In the Quotes form, click Update Opportunity.

NOTE: The first time you delete a line item, the product is not deleted in the 
Opportunity view. A product is only deleted from the Opportunity products when 
the associated quote number is equal to the quote number of the quote from which 
you are updating. The first time you click Update Opportunity the quote numbers 
are not yet assigned to the Opportunity Product. When you click Update 
Opportunity the quote numbers are assigned, the opportunity product is identified, 
and the deleted quote is deleted in the opportunity. 

Updating an Opportunity
After you have added the appropriate line items and completed the quote, you need 
to update the opportunity with the quote information. It is important to keep your 
opportunity information in sync with your quote information to maintain accurate 
forecasts and charts. 

To update quote information to the opportunity

1 Navigate to the Quotes screen.

2 In the Quotes list, select the quote for which you want to update the opportunity, 
and then click Update Opportunity.

The new or modified products and prices appear in the opportunity.
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Using Delta Quotes
When you create a quote, you can add to or make changes to the customizable 
products the customer has already purchased. Generally, these products, which are 
also called customizable assets, have attributes and features that can be modified. 
For instance, a company has purchased several hundred computers, which can have 
different specifications for drive capacity, memory, and peripherals that can be 
upgraded.

Delta Quotes differ from Favorites in that only new or changed items have a price. 
Unchanged items have no price associated with them. When you add a Favorite to 
a quote, all the items in the customizable product have a price.

Favorites are new products being sold for the first time. Delta Quote products are 
items being sold as add-ons or replacement components for products you have 
already sold. Using the computer sale example, you can provide the customer’s 
company with a delta quote that includes additional memory or other upgrades 
after the customer has owned the computers for a while. You can create a quote and 
select the customer’s customizable asset, which in this case is the computer model. 
Then, you can configure the asset by adding or removing items and saving your 
changes. 

You can add a customizable asset to an existing quote as described in the following 
procedure.

To add a delta quote

1 Navigate to the Quotes screen.

2 In the Quotes list select the quote to which you want to add a delta quote.

3 Click the Line Items view tab.

4 Click the menu button, and then choose Delta Quote.

The Customizable Asset dialog box appears, displaying all customizable product 
assets that the product administrator has configured for the account. 

5 Locate the asset you want to add to the quote, and then click OK.
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6 Highlight the customizable asset and click the Customize button in the Line 
Items list.

The configuration of the customizable asset displays in the session’s selection 
pages.

7 Revise the configuration of the customizable asset by making selections and 
click Done to return to the Quote list.

The revised configuration displays in Quotes screen’s Line Items view.

Viewing Delta Status for a Quote Item
All the items in the revised asset receive a status when they are copied to the quote 
after a configuration session. The status tells you whether the item was changed 
during the configuration session. 

Table 6 describes the Delta Status values.

Table 6. Delta Status Values

Delta Status Comments

Existing All items that were not changed. These items display no price.

Modified All items for which attribute settings have changed. All items with a 
status of Modified are priced as new items.

New All items that have been added or for which the quantity increased. If the 
quantity of an item increased, the original quantity is shown with a status 
of Existing. A second entry in the quote shows the increase, has a status 
of New, and displays a price.

Removed All items that were removed or decreased in quantity. If the quantity of 
an item is reduced, the new quantity appears with a status of Existing. A 
second entry in the quote shows the reduction and has a status of 
Removed.
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To view the delta status of an item in a delta quote

1 Navigate to the Quotes screen.

2 In the Quotes list, select the quote for which you want to view details.

3 Click the Line Items view tab and select the item for which you want to view 
status information.

4 Click the Line Item Detail subview tab.

The Delta Quote status displays in the Delta Status field.

You may need to click the show more button to see the field. 

Using Favorites
Favorites are packages that you have created and want to reuse at another time for 
other quotes. For instance, you notice that there are several common configurations 
for the PC computer system that you sell. Rather than create these manually for 
each quote, you can create one and save it, then reuse it the next time you need to 
produce a similar quote.

For information on the differences between a Favorite and a Delta Quote, see “To 
add a delta quote” on page 162.

Saving a Favorite
After you have created a specific product package, you can save it to use again.

To save a favorite

1 Navigate to the Quotes screen.

2 In the Quotes list, drill down on the hyperlink in the Name field. 

3 In the Line Items view, click the menu button, and then choose Save as Favorite.

NOTE: This assumes that you have already entered line item information and you 
want to reuse the information.
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4 In the Save as Favorites dialog box, enter a name.

The following figure shows the Save a Favorite dialog box, with fields for a name 
and the Save as a personal favorite check box. Clearing the check box allows all 
users to use this favorite.

5 In the Favorites dialog box, click Save.

Using Favorites Manager
The Favorite Managers permits you to access previously saved package bundles that 
were used in a quote. 

To use Favorites Manager

1 Navigate to the Quotes screen.

2 In the Quotes list, drill down on the hyperlink in the Name field.

3 In the Line Items list, click the menu button, and then choose Favorite Manager.

4 In the Favorites dialog box, select the favorite, and then click Start from Favorite.

The favorite you selected appears in the Line Items list.

5 In the Line Items list, click Customize to change the package.

To save this modification as a favorite, see “To save a favorite” on page 164.
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Adding Payment and Billing Information
After completing the sales order, you can enter payment and billing information. 
You can send a customer an order at an address that differs from the main address 
associated with either the account or the contact information and you can enter an 
address for the order without updating the customer’s permanent address.

To add billing, payment, tax and terms information

1 Navigate to the Opportunities screen.

2 In the Opportunities list, select the opportunity with which the quote is 
associated.

3 Click the Quotes view tab.

4 In the Quotes list, drill down on the quote name hyperlink.

5 Click the Payments view tab.

6 In the Payments form, complete the necessary fields.

NOTE: The billing address is automatically populated based on the account 
information. To bill to a different address associated with the account, or to add 
a new address, click the select button in the Bill to Address field. The Bill To 
Address dialog box appears, allowing you to edit, add or select an address.

To add shipping information

1 Complete Step 1 through Step 4 in the previous procedure.

2 Click the Fulfillment view tab.

The shipping address is automatically populated based on the account 
information.

3 To ship to a different address associated with the account, or to add a new 
address, click the select button in the Ship to Address field.

The Ship To Address dialog box appears, allowing you to add or select an 
address.
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Revising a Quote
You can make changes to an initial quote to keep it updated with the appropriate 
products, price lists, discounts, and so on. During negotiations with a customer, you 
can add or delete products from a quote and compare features and price.

The Revise feature allows you to edit or revise your original quote. Revisions do not 
create a new quote, but instead add a revised quote to the list associated with the 
opportunity.

To revise a quote

1 Navigate to the Opportunities screen.

2 In the Opportunities list, select the opportunity with which the quote is 
associated, and then click the Quotes view tab.

3 In the Quotes list, select the quote and then click Revise.

A new quote, with the same quote number, appears beneath the one you 
selected to revise.

4 Revise the information as needed, and then click Save.

The following figure shows both the original quote record and the revised quote 
record in the Quotes list. You can verify the revision by looking in the Revision 
column.

NOTE: When you revise a quote, the original quote becomes inactive and read-
only.
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Creating Orders from Quotes
After you complete the initial quote and the customer agrees to the products and 
prices, you can create a sales order.

To create an order from your quote

1 Navigate to the Quotes screen.

2 In the Quotes list, select the quote for which you want to generate an order.

3 Click the Orders view tab.

4 In the Orders list, click New.

The order inherits field values from the quote.

5 In the Type field, select Sales Order from the drop-down list.

6 In the Orders list, drill down on the Order # hyperlink.

The Orders line items view appears.

7 In the Line Items list, click New to add order line items.
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This chapter explains how the Target Account Selling (TAS) module integrates with 
Siebel Sales to help sales professionals win more deals. The TAS module provides 
automated support and coaching to help sales professionals in the following ways:

■ Assess opportunities, relationships with key customer contacts, and their 
competitive position

■ Develop competitive and relationship strategies to win the deal

■ Execute the strategy and track progress against the action plan

The TAS opportunity management methodology is a separately licensed offering 
developed by Siebel MultiChannel Services. For information on TAS administrative 
tasks, see Applications Administration Guide, MidMarket Edition.
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Target Account Selling Overview
The Target Account Selling software provides full support for the Target Account 
Selling (TAS) sales methodology from Siebel MultiChannel Services. Using the 
Target Account Selling methodology and the Target Account Selling software, sales 
professionals align themselves with the right people and develop winning sales 
strategies. TAS support allows you to assess opportunities, conduct organizational 
and competitive analysis, and develop and execute a winning sales strategy.

The Siebel Target Account Selling software module provides the following features:

■ Full support for the Target Account Selling methodology.

■ A TAS Coach to help sales professionals assess their opportunities, including 
Tips to reinforce key concepts in the TAS methodology.

■ A TAS Coach that recommends what competitive strategy to take, and identifies 
the pros and cons of the recommended strategy.

■ Automatic creation of the Organization Map that allows you to view both the 
formal hierarchy and lines of influence in the customer organization. This helps 
sales professionals develop relationship strategy.

■ Support in identifying and ranking the decision criteria of each contact.

■ Team planning to make sure that key Customer Milestones are addressed.

■ Automatic creation of the TAS Opportunity Plan. The report can be configured 
to print selected sections.

■ Automatic creation of the TAS Initial Plan.
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Business Scenario
A sales representative meets with a customer and discovers a new opportunity. The 
sales representative plans to use the Target Account Selling (TAS) methodology from 
Siebel MultiChannel Services (MCS) to develop a sales strategy for this new deal. 
TAS is supported by his Siebel Sales application, allowing the sales representative 
to analyze the opportunity and its multiple decision makers.

Opportunity Assessment
The sales representative pulls up the opportunity within the Siebel Sales application 
and clicks the TAS view tab to begin the process. He sees several views that he can 
use to profile and assess the opportunity, develop his value proposition and 
competitive strategy, and create a detailed action plan to achieve his goals. 

He begins by developing an overview of the opportunity. He enters some high-level 
information, including a profile of the account and the opportunity. This 
information provides strategic insight that his sales team can use and helps him to 
connect the project to the customer’s business drivers. The sales representative also 
enters details about his goal for the opportunity, the solution he is offering, and the 
business value this solution provides. He continues by entering a description of the 
compelling event that is causing the customer to act. This helps him to determine 
the customer’s sense of urgency to close the deal. He concludes by summarizing his 
high-level strengths and weaknesses for the deal.

Now that he has a general overview of the opportunity, he begins to assess his 
position using the TAS criteria that Siebel MCS has developed from analyzing the 
best practices of top sales professionals. He also rates the position of his key 
competitors using these criteria. He uses the TAS Coach on the Assessments screen 
to help him complete the assessment. The assessment helps him qualify the 
opportunity and understand his company’s position in the deal.
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Competitive and Relationship Strategy Development
Next, the sales representative begins to analyze his competitors for this opportunity 
and determine what strategy he should take to win the deal. He can use the TAS 
Coach, available from the Competitive Analysis screen, for competitive strategy 
recommendations.

He continues by analyzing the prospect’s organization. He maps both the formal 
and informal structures so that he can be sure he is spending time with the right 
contacts. When he has completed his analysis, he automatically creates an 
organizational chart that summarizes his assessment and identifies key players and 
relationships he can use to close the deal.

Now that he knows who to talk to, the sales representative moves on to develop his 
relationship strategy. He enters the business and personal agenda for each contact. 
This preparation helps him to determine what message to deliver to each contact.

Strategy Execution
The sales representative is now prepared to develop his action plan to win the 
opportunity. First, he navigates to the Customer Milestones view to document key 
events or milestones in the customer’s buying process. This view helps him plan 
the activities that he and his sales team should take to address the customer’s 
requirements at each milestone. Then, he enters key action steps and resources 
needed and assigns the actions to members of his sales team. He can choose to have 
the activities appear in his calendar, activities, or to-do list, or in those of another 
assignee. He navigates to the PRIME Activities view where he can see all the 
activities he created to meet customer milestones, as well as add action items 
required to win the deal. He also makes some additional notes about the 
opportunity and makes the notes available for the entire team to view.

The sales representative’s manager requests a copy of the TAS Opportunity Plan. 
The sales representative configures the report to display relevant sections of the 
Opportunity Plan, generates the report, and then emails it to his manager. 
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Siebel Target Account Selling (TAS) consists of eight views that automate the steps 
in the TAS methodology:

■ Overview

■ Assessment

■ Competitive Analysis

■ Organizational Analysis 

■ Relationship Strategy

■ Customer Milestones

■ PRIME Activities

■ Notes

Information in these views appear in the TAS Initial Plan report.

Completing a TAS Overview
The Overview view provides a starting point that sales professionals can use to 
consolidate their observations about the account and opportunity. The Overview 
view is where salespeople begin as they work through the TAS methodology. Using 
this view sales professionals can profile their customers’ important business 
initiatives and requirements. In addition, sales professionals can summarize the 
strategic goal, value proposition, and overall position. By completing the entry 
fields in the Overview view, sales professionals can share strategic account and 
opportunity insights with their sales teams.

To complete a TAS overview

1 Navigate to the Opportunities screen.

2 In the Opportunities list, select the opportunity.

3 Click the Target Account Selling view tab.

4 From the Show drop-down list, choose Overview.
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5 In the TAS Opportunity Overview form, complete the necessary fields. 

These fields are described in the following table.

TIP: Position the pointer on the  icon to display information on the view.

Field Comments

Customer’s Business Profile Describe the customer’s business conditions. Identify 
the customer’s major lines of business, affiliations, 
products, and markets. Include information about 
recent mergers and acquisitions.

Customer’s Revenue Enter the customer’s annual revenues or sales.

Profit Enter the customer’s annual profit.

Fiscal Year End Enter the month and day in which the customer's 12-
month accounting period ends.

Opportunity Profile Describe the customer’s project or application. 
Identify the customer’s business objectives for the 
project, the total cost and budget for the project, and 
how the project affects the customer’s overall 
business.

Goal Describe your desired, long-term position with the 
customer. Identify how a closer relationship with you 
advances the attainment of their business goals. Also 
include the long-term gain for your business such as 
future or strategic value.

Customer’s Compelling Event Describe what is driving the customer to make a 
decision or change the current situation. Identify the 
payback if the customer makes a change, or the 
consequences if they do not act. Note the specific date 
associated with the consequences or payback.

Our Solution Describe the solution you plan to offer to the customer. 
Address how the solution works in the customer’s 
environment and how it meets their compelling event. 
Include any alliances or business partner solutions 
required to make it operational for the customer.
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NOTE: If this is a new opportunity, you must create a new record and associate it 
with an account before you can enter text in the Customer’s Business Profile field. 
For more information, see Chapter 4, “Opportunities.”

Assessing an Opportunity
Sales professionals can use the Assessments view to evaluate the opportunity using 
criteria developed by Siebel MultiChannel Services. Assessments must be 
completed before determining the best strategy. An assessment focuses on the 
following four key questions:

■ Is there an opportunity?

■ Can we compete?

■ Can we win?

■ Is it worth winning?

Sales professionals assess the position of both themselves and their top competitors 
against these criteria. As the sales campaign progresses, sales professionals can 
repeat this assessment, and then compare the results to past assessments to 
evaluate and monitor their position at each sales stage.

Critical Success Factors Identify actions you, the competition, and your 
customer must do for you to win this opportunity.

Our Unique Business Value Describe your value proposition. Make sure it is 
specific to this customer, defines a measurable 
business result, and creates credibility by proving your 
ability to deliver. The value proposition should be 
confirmed with the customer and differentiate you 
from your competitors.

Our Strengths Identify business, organizational, and political issues 
that give your sales team an advantage in the deal.

Our Weaknesses Identify business, organizational, and political issues 
that could put your sales team at risk in the deal.

Field Comments
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The first few times you perform an assessment, use the TAS Coach to help you 
evaluate and answer each set of assessment questions. After you are familiar with 
assessment issues, you can perform an assessment using the Assessment form. 

To begin an assessment

1 Navigate to the Opportunities screen.

2 In the Opportunities list, select the opportunity.

3 Click the TAS view tab.

4 In the Target Account Selling form, from the Show drop-down list, select 
Assessments.

The Assessments list includes all the assessments you and your sales team have 
performed to date. Use the Assessments list to compare opportunity assessments 
for your company and your competitors.

5 In the Assessments form, click New.

6 In the new record, the Assessment For field defaults to Our Company for self 
assessments. If you are assessing a competitor’s position, click the select button 
and choose the competitor. 

7 In the Assessment form, click TAS Coach, and complete the assessment criteria 
questions. For more information, see “Using the TAS Coach” on page 177.

If you have performed a number of assessments and are familiar with the criteria 
and methodology, use the Assessment form to rate the criteria.
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Using the TAS Coach
The Assessment TAS Coach, shown in Figure 2, uses Siebel SmartScripts technology 
to help sales professionals evaluate opportunities. The explorer pane expands to 
display individual questions in each question set, and the form at right provides 
information on assessment considerations and rating selection.

To perform an assessment using TAS Coach

1 Assess the position of each of the criteria in the Assessments list by selecting a 
plus (+), a minus (-), or a question mark (?) from the drop-down list.

2 Click Next to advance to the next set of criteria questions.

Click Previous to return to criteria you have already assessed.

Click Cancel to return to the Assessments view without saving the assessment.

If you want to pause in the middle of a TAS Coach assessment, and then return 
to the assessment at a later time, click Finish Later. The assessment does not 
appear in the Assessments list until it is completed. 

Your assessment is saved in SmartScripts screen’s My Saved Session view. Use 
Site Map to navigate to the SmartScripts screen.

If you do not have enough information to answer the question, select the 
question mark (?).

Figure 2. TAS Coach Screen
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3 When you have rated all criteria, click Finish to return to the Assessments list.

NOTE: You must click Finish to save the criteria to the form.

Developing Your Competitive Strategy
The Competitive Analysis view helps sales professionals to develop competitive 
strategy. For each competitor, the sales team can evaluate strengths and weaknesses 
and anticipate the competitor’s strategy. The view also allows the sales team to 
assess its own position against the competitor, and to develop its strategy to win the 
deal. 

Use the TAS Coach to help you develop and refine your strategy. TAS Coach 
provides recommendations based on the information you enter.

NOTE: If you use the TAS Coach to refine your strategy, enter information in the Our 
Competitive Strategy field. If you are analyzing a competitor’s strategy, enter the 
information in the Competitors list.

When you determine what your strategy will be, enter a summary in the Our 
Competitive Strategy text field in the Competitive Analysis view.

To add competitive analysis information

1 Navigate to the Opportunities screen.

2 In the Opportunities list, select the opportunity.

3 Click the Target Account Selling view tab.

4 In the TAS form, select Competitive Analysis from the Show drop-down list.

5 In the Competitors list, click New.

A new row appears.

6 In the new record, click the select button in the Competitor field.

7 In the Pick Competitors dialog box, select the competitor to assess, and then 
click OK.
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8 In the new Competitor record, complete the necessary fields.

Enter your strategy, based on what you think the competitor will do.

Using the TAS Coach for Competitive Analysis
The TAS Coach can help you develop a competitive strategy after you have 
completed the TAS Assessment for your company and competitors. You may need 
to refer to your assessment criteria ratings during a TAS Coach session, and may 
want to review or print the assessments before starting. See “Generating Reports” 
on page 191.

To use the TAS Coach for competitive analysis

1 Navigate to the Opportunities screen.

2 In the Opportunities list, select the opportunity.

3 Click the Target Account Selling view tab.

4 In the TAS form, select Competitive Analysis from the Show drop-down list.

5 In the Competitive Strategy form, click TAS Coach.

The TAS Coach screen appears, as shown in the following figure, detailing 
strategy types such as Fragment, Frontal, and Disengage, and includes a 
description of how to use the TAS coach.
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6 During the TAS Coach session, answer each question presented, and then click 
the Continue hyperlink to proceed to the next question.

During the session, an interim evaluation of each answer is provided, outlining 
the relevant issues that you must consider.

Click the Back hyperlink to return to a previous question.

At the conclusion of the session, TAS Coach recommends the type of strategy to 
take.

7 At the TAS Coach Recommends screen, drill down on the Click here for 
variations hyperlink for additional strategy options.

8 When you have completed the TAS Coach session, click Finish to return to the 
Assessments view.

If you plan to use the recommendations, in the Competitive Analysis view enter 
the strategy information in the appropriate fields.

Conducting an Organizational Analysis 
After completing additional assessments of the customer's organization to 
understand who the most influential people are and how to use these relationships, 
sales professionals can use the Organizational Analysis view to create formal and 
informal organizational charts that visually summarize their contact analyses.

The Organizational Analysis view toggles between a Contacts list, and an 
Organization Map. Contacts previously associated with the opportunity 
automatically appear in both views. The contacts shown in the Contacts list appear 
in the Organization Map view. 
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The toggle control list is shown in Figure 3. You can click New in either the Contacts 
list view or the Organization Map to create contact records. Position the pointer on 
the “i” icon to display information on the view.

Regardless of which view you use to create or select contacts, analyze each contact 
based on the criteria taught in the TAS methodology training program. This criteria 
includes Buying Role, Your Status, Level of Influence, Adaptability to Change, and 
Coverage.

The Level of Influence that you assign to each contact determines the degree of 
shading that appears in the contact node in the Organization Map. Table 7 explains 
the contact node shading for each value in the Level of Influence field.

You can also map the politics in the customer organization by identifying formal 
and informal lines of influence between contacts. Mapping informal lines of 
influence helps you identify contacts who may not be ranked highly (and are easier 
to access) but have significant influence on key decision makers. 

Figure 3. Organizational Analysis View, Contacts List and Organization Map Toggle

Table 7. Level of Influence Shading for Contacts

Value in Level of Influence Field Shading on Organization Chart

Low None

Political Structure (Medium) Light gray

Inner Circle (High) Dark Gray
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To begin an organizational analysis

1 Navigate to the Opportunities screen, and then select an opportunity in the 
Opportunities list.

2 Click the Target Account Selling view tab.

3 From the Show drop-down list, choose Organizational Analysis.

The Organization Map view appears.

To add a new contact in the Organization Map

1 In the Organization Map view, click New.

2 In the Add Contacts dialog box, click New.

3 In the Contact form, complete the fields, and then click Save.

The following figure shows the Organization Map contact form that includes 
assessment fields such as Adaptability to Change, Buying Role, and Coverage.

When you toggle to the Organization Map, this information appears in the 
contact node box, illustrated on the following page.

To add a contact in the Contacts list

1 From the toggle list, choose Contacts.

2 In the Contacts list, click New.

3 In the Add Contacts dialog box, select the contact or contacts you want to add, 
and then click OK.

In the Add Contacts dialog box, click New to create a new contact.

4 Complete the fields to analyze the contact.
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To create the organization map

1 In the view drop-down list toggle, select Organization Map.

The organizational chart displays the nodes (boxes) containing information for 
each of the contacts you have analyzed and associated with the opportunity. 

The following figure shows an example of a contact node with Level of Influence 
shading. The node includes information about the contact, such as the contact’s 
title and other contact analysis information (Decision Maker, Mentor).

You can visually represent the formal hierarchy in the organization by creating 
the Organization Map of key customers in the deal.

2 Select the contact node and drag it beneath the contact node that shows the 
contact’s manager.

When you drop the contact node on the manager’s node, a line appears between 
the nodes, reflecting the reporting relationship.

3 Repeat this procedure for each contact until you have completed the 
organization chart.

NOTE: The reporting relationships are also stored in the Contacts list (toggle 
view). The Manager Last Name and Manager First Name fields in the contact 
record are automatically populated. To expose this information in the contacts 
list, click the menu button, and then select Columns Displayed.

To delete contacts on the Organization Map

■ Select the contact node, right click the mouse, and choose Edit > Delete from 
the menu.
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To draw lines of influence

1 In the Organization Map, press the CTRL key and simultaneously select the 
contact. 

2 Drag and drop the selected contact node on other contacts to draw the lines of 
influence.

The CTRL key must be depressed throughout this process for the informal line 
of influence to appear. 

NOTE: This information is automatically updated in the Relationships view of the 
Contacts screen. You can indicate lines of influence in the Relationships view if 
you prefer.

To delete lines of influence on the Organization Map

■ Select the line, right click with the mouse, and then choose Edit > Delete from 
the menu.

To print the organization map

1 From the Organization Map, right click your mouse, and then select Zoom from 
the menu to choose the Zoom level at which you want to print the chart. 

2 From the Organization Map, right click your mouse again, and then choose Print 
from the menu. 

The Organization Map prints at the selected zoom level. Large charts print 
across multiple pages.

NOTE: The Organization Map does not print in the Initial Plan Report or 
Opportunity Plan Report. You must print it from the Organization Map view 
using the right-click menu.
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Adding Customer Milestones
Milestones are formal steps in the customer’s buying process. The Customer 
Milestones view helps sales professionals identify and track customer requirements 
that must be met as the sales cycle progresses. After the milestones are set, use the 
Our Activities list to target specific activities that need to be accomplished to meet 
each milestone. These activities might include product demonstrations, 
benchmarks, and other activities required to make the sale. Figure 4 shows the 
Customer Milestones list, and the activities associated with the selected milestone 
in the Our Activities list.

Milestones are similar to Activity Plan templates that are created with predefined 
activities. For example, the initial milestone, Request Offering, is associated with 
recommended activities to be performed by you and your sales team. These 
activities might include understanding the problem or opportunity, defining the 
customer’s Compelling Event and confirming the budget, completing an 
opportunity assessment, and developing an organization map for the customer’s 
business. 

A sample of customer milestone types is included with the Siebel Sales application. 
Your administrator can change the milestones, based on your business needs. You 
and your sales team can create, edit and delete activities associated with the 
milestones that address the opportunity.

Figure 4. Customer Milestones View with Associated Activities
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To add a milestone

1 Navigate to the Opportunities screen.

2 In the Opportunities list, select the opportunity.

3 Click the Target Account Selling view tab.

4 In the TAS form, from the Show drop-down list, select Customer Milestones.

5 In the Customer Milestones list, click New.

A new record appears in the list, with the current date in the Date field.

6 Complete the necessary fields.

a In the Event field, select the type of event from the list, and then click Save.

A set of suggested activities appears in the Our Activities list. You must save 
the type of event for the activities to appear.

b In the Description field, enter information about the event.

c In the Customer Responsibility field, click the select button, and then from 
the Contacts dialog box, choose the customer contact who is the key contact 
and owner of the milestone event.

Repeat Step 5 and Step 6 until you have entered all key milestone events.

NOTE: Review the recommended activities for each milestone before adding new 
milestones.

To add associated activities to each milestone

1 See “To add a milestone” to create the Milestone.

2 In the Our Activities list, click New, and then complete the necessary fields for 
the activity.

a In the Type field, choose the activity type from the list.
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b In the Display In field, choose where you want the activity to appear.

Options are Activities Only, Calendar and Activities, and To Do and Activities.

NOTE: If you choose Calendar and Activity as the display method, you must 
enter a start date for the activity for it to appear in the calendar.

c In the Resources text field, describe the resources required to support the 
activity.

d If the activity will be delegated, for example, from a manager to a member of 
the sales team, click the hyperlink in the Owner field, and query for the new 
owner in the Employees list.

The default owner is the User ID of the activity creator.

Developing Relationship Strategy
The Relationship Strategy view helps sales professionals to discuss the right 
decision criteria with the right people. Information captured in this view facilitates 
the development of a relationship strategy for each of the key players identified. The 
view makes it easy for sales teams to share their understanding of both the business 
and personal agendas of each contact, easing the execution of the desired 
relationship strategy.

To add decision criteria

1 Navigate to the Opportunities screen.

2 In the Opportunities list, select the opportunity.

3 Click the Target Account Selling view tab.

4 In the TAS form, from the Show drop-down list, select Relationship Strategy.

5 In the Relationship Strategy list, click New.
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6 From the Add Contacts dialog box, select the contact or contacts you want to 
add, and then click OK.

NOTE: All contacts added in the Organization Map automatically appear in the 
Contacts list, and all contacts added in the Contacts list appear in the 
Organization Map.

7 In the Relationship Strategy list, complete the Business Agenda, Personal 
Agenda and Relationship Strategy fields for each contact.

To add decision criteria

1 In the Relationship Strategy list, select a contact.

2 In the Decision Criteria Key Issues list, click New.

3 In the Add Issues form, click Go. 

4 In the Add Issues dialog box, select the issue and click Add.

5 In the Decision Criteria list, complete the Rank and Comments fields for the 
issue.

6 Drill down on the hyperlink in the issue name field to view more information 
associated with the issue.

Viewing PRIME Activities
The PRIME Activities view helps sales professionals to develop the action steps 
required to execute the strategy to win this opportunity. The PRIME acronym 
underscores the initiatives that are used: 

■ Prove your value

■ Retrieve missing information

■ Insulate against competition

■ Minimize your weaknesses

■ Emphasize your strengths
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These activities can be assigned with due dates to specific members of the sales 
team and automatically appear in individual calendars and activity lists. Use this 
view to keep the entire sales team on the same page and measure progress in 
implementing the sales strategy.

Activities created in the Our Activities list in the Milestones view also appear in the 
PRIME Activities list, providing a convenient method for tracking. (In the Customer 
Milestones list, you must select the milestone to see the associated activities.)

Using this view, you can create activities that are not specific to milestones, such as 
follow up actions associated with Assessments and the Organizational Analysis.

To add PRIME activities

1 Navigate to the Opportunities screen.

2 In the Opportunities list, select the opportunity.

3 Click the Target Account Selling view tab.

4 In the TAS form, from the Show drop-down list, select PRIME Activities.

5 In the PRIME Activities list, click New.

6 Complete the necessary fields for the new activity.

You need to identify the actions and resources required to implement your 
strategy and select a member of your sales team who is responsible for the 
activity.
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Adding Notes
The Notes view consolidates comments (for example, notes and directions) created 
by various members of the sales team. These can be marked for general viewing or 
can be kept private. This makes it easy to aggregate and track observations about 
the opportunity throughout the sales process.

To add a note

1 Navigate to the Opportunities screen.

2 In the Opportunities list, select the opportunity.

3 Click the Target Account Selling view tab.

4 In the TAS form, from the Show drop-down list, select Notes.

5 In the Notes list, click New.

6 In the Type field, select the type of note from the drop-down list, and then enter 
a description of the note.

7 From the drop-down list, choose whether the note should be public or private.
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Generating Reports
You can automatically create reports to make it easier to review your TAS plans. 
These can be printed or emailed to share with your sales team. Available reports 
include the TAS Opportunity Plan and TAS Initial Plan reports. You can configure 
the Opportunity Plan report to print specific sections.

The TAS Opportunity Plan Report prints all the Assessments completed for Our 
Company and all competitors on the three most recent dates. The TAS Initial Plan 
Report prints all the Assessments completed for Our Company and all competitors 
on the one most recent date. 

To create a report

1 Navigate to the Opportunities screen.

2 In the Opportunities list, select the opportunity.

3 Click the Target Account Selling view tab.

4 From the application-level menu, choose View > Reports.

The Reports dialog box appears.

5 From the Select a Report drop-down list, select the report to display and then 
click Run.

Options are Opportunity Plan and Initial Plan reports.

■ To print sections of the Opportunity Plan report, click the check boxes 
associated with the sections in the Configure Opportunity Plan dialog box, 
shown in the following figure, and then click Finish.

You can save, print, or email the report if desired.
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This chapter explains how sales professionals can use Miller Heiman's Strategic 
Selling methodology within the Siebel Sales application to close new business. The 
Strategic Selling module is a separately licensed product. Using the Strategic Selling 
module, sales professionals can enter sales objectives, assess buying influences, 
understand their competitive position, and create an action plan to execute the 
competitive strategy. This information is available in a report, called the Blue Sheet. 
For information on Strategic Selling administrative tasks, see Applications 
Administration Guide, MidMarket Edition.
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Strategic Selling� Overview
The Strategic Selling software module in Siebel Sales provides full support for the 
Strategic Selling methodology from Miller Heiman. Sales professionals can reinforce 
and use the Strategic Selling sales process within the Siebel eBusiness Applications 
suite, using their sales methodology and their sales tools together to close new 
business. Siebel Strategic Selling software provides the following features:

■ Support for the Strategic Selling methodology (a separately licensed service 
available through Miller Heiman, Inc.)

■ Assessment of the opportunity compared to the ideal criteria

■ Analysis of key contacts and development of a relationship strategy

■ Tools to improve your position based on your sales objective

■ Support in developing an action plan to execute your sales strategy

■ Automatic generation of a Blue Sheet report 
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Business Scenario
A sales representative joins the sales team for a new opportunity. Before he makes 
any calls into the account, the sales representative plans to perform a Miller Heiman 
Strategic Selling analysis of the opportunity. The sales representative locates the 
opportunity in his opportunity list and then selects the Strategic Selling view tab.

In the Single Sales Objective view, the sales representative reviews the information 
typically shown at the top of the Strategic Selling Blue Sheet. He gauges his general 
feeling about the opportunity. He notes that two fields have been carried over from 
the Siebel account form—the dollar volume of business that he is currently doing 
with the account and the amount that he plans to do with the account over the next 
year or more. These two fields are read-only. The sales representative proceeds to 
assess his competitive position and determines the timing for his priorities. He 
selects the Strategic Selling Assessment template and evaluates the opportunity to 
determine how it compares against an ideal customer. Based on his evaluation, the 
opportunity is automatically scored.

The sales representative then navigates to the Buying Influences view. Contacts 
associated with the opportunity automatically are shown in the view. He adds new 
contacts and assesses his relationship strategy with each of them. Each contact can 
play a variety of roles in the evaluation, and each buyer can have a reason for 
participating in the evaluation. The personal win and business results tell the sales 
representative and his team the benefits for his contact, and the ratings show how 
well the sales representative has covered all aspects of the opportunity. The sales 
representative then enters evidence to support his ratings.

In the Position Summary view, the sales representative completes a description of 
his company’s strengths and weaknesses (red flags) in the deal. He also identifies 
information required to close this opportunity.
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Now that he has set his Single Sales Objective and completed his customer and 
competitive analysis, the sales representative creates an action plan for his team to 
win this opportunity. He goes to the Possible Actions view and adds a list of possible 
actions generated during a collaborative session with his team. The actions the 
team will take are marked Best. These automatically appear in the Best Actions view 
where the sales representative assigns them to sales team members and marks the 
due date for each action. These activities automatically appear on the assignee’s 
calendar, to-do list, or activities list, based on the choice in the Display In field for 
each activity. The sales representative can check this list at any time as the deal 
progresses to track the status of the activities.

After the sales representative has finished entering and updating his Strategic 
Selling information, he can generate a Blue Sheet report that he can print or email 
to share with his team.
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Sales professionals can reinforce and use the Strategic Selling sales process within 
the Siebel eBusiness Applications suite, combining sales methodology and sales 
tools to more efficiently close new business.

Meeting the Single Sales Objective 
Siebel Strategic Selling helps sales professionals meet their sales objectives for the 
account. By assessing and testing their position, sales professionals can make sure 
their sales teams evaluate the probability for meeting the Single Sales Objective, as 
taught in the Miller Heiman Strategic Selling process. The software module also 
helps sales professionals analyze whether or not they are working on the right sales 
objective, or an objective where closing the deal meets both the customer’s needs 
and the sales professionals’ long-term goal for the account. Sales professionals can 
evaluate the opportunity compared to an Ideal Customer profile, providing an 
understanding of their position and underscoring the best strategy to take.

To assess your position

1 Navigate to the Opportunities screen.

2 In the Opportunities list, select the opportunity.

3 Click the Strategic Selling view tab.

The Strategic Selling Position form, Ideal Customer Assessment list and Ideal 
Customer Criteria list appear with the Opportunity form.
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4 In the Position form, complete the fields to identify the competition for the 
opportunity and assess your position.

The following table describes the fields in the Position form.

Assessment criteria are taught by Miller Heiman instructors in the Strategic 
Selling methodology workshop.

5 In the Ideal Customer Assessment list, click New.

6 In the new record, click the select button in the Name field to choose the Ideal 
Customer Criteria template, and then click Save. 

An explicit Save is required for the assessment criteria to appear.

Field Comments

Adequacy of Current Position Select the value that best describes how you feel 
about your current position. Examples of values 
are Euphoria, Great, OK, Secure, Comfort, and 
Worry.

My Position vs. Competition Select the value that describes your position 
compared to your key competitors. Examples of 
values include Only Alternative, Front Runner, 
Shared, and Zero.

Timing for Priorities Select the value that describes the timing for your 
priorities. Examples are Urgent, Active, Work It In, 
and Later.
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7 In the Ideal Customer Criteria list, query to select a value for each assessment 
criterion.

The following illustration shows an Ideal Customer Assessment record, and the 
Ideal Customer Criteria list shows the criteria associated with the assessment.

Click the select button in the Value field to view each value and its description. 
The opportunity assessment is automatically scored based on the selected 
values.

The Assessment Score and its percentage of the Max Score, defined in the 
Assessment template, appear in the Ideal Customer Assessment list.
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Adding Buying Influences Information
The Buying Influences view helps sales teams identify the role each contact plays 
and each contact’s reason for participating in the project. The personal win and 
business results recorded in this view help the sales professional to understand the 
outcome benefit for the contact. By understanding the business and personal 
agendas of their contacts, sales professionals can form effective relationships and 
consider where to dedicate resources.

To add buying influence information

1 Navigate to the Opportunities screen.

2 In the Opportunities list, select the opportunity.

3 Click the Strategic Selling view tab.

4 From the Show drop-down list, choose Buying Influences.

5 In the Buying Influences list, click New.

6 In the Add Contacts dialog box, select contacts you want to add, and then click 
OK.

To enter new contacts, click New in the Add Contacts dialog box.

7 In the Buying Influences list, complete the fields for the contact.

a Indicate the role of the contact by placing a check mark in each applicable 
field.

Fields include Economic Buyer, User Buyer, Technical Buyer, and Coach.

b Enter information in the Personal Win and Business Results fields for each 
contact.

c Select a Rating and Mode for each contact.

Examples of Rating are +2 Interested, and +4, Strongly Supportive. 
Examples of Mode are Growth, Trouble, and Overconfident.

d Enter your Evidence to Support Rating in the text field.
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Adding Possible Actions 
In the Possible Actions view, the sales team can brainstorm feasible actions for 
advancing an opportunity and then create an action plan based on Best Actions.

To add possible actions

1 Navigate to the Opportunities screen.

2 In the Opportunities list, select the opportunity.

3 Click the Strategic Selling view tab.

4 From the Show drop-down list, choose Possible Actions.

5 In the Possible Actions list, click New.

A new row appears in the Possible Actions list.

6 In the new record, select the check box in the Best field to mark this action as 
best.

All actions flagged as Best appear in the Best Actions view.

7 In the What field, enter a description of the action.

Repeat Step 6 through Step 7 to enter all the best actions your sales team can 
accomplish.

Adding Best Actions 
The Best Actions view presents the actions in the Possible Actions view that the 
sales team has selected as the best choices to advance the opportunities. This view 
helps keep the entire sales team on the same page by providing one location for 
action planning and logging status. You can assign best actions to people on your 
opportunity team and these actions appear in their activities list. It also helps teams 
monitor cumulative progress towards sales goals.

To add best actions

1 Navigate to the Opportunities screen.

2 In the Opportunities list, select the opportunity.
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3 Click the Strategic Selling view tab.

4 From the Show drop-down list, choose Best Actions.

The possible actions you previously selected as best automatically appear in the 
Best Actions list.

5 Click New in the Best Actions list, and complete the fields for the new record.

The following table describes the fields for a Best Action.

Field Comments

What Enter the description of the action in the text field. This description 
appears in the Activities list for the Opportunity. You can set the 
Display field to display the best action in your Calendar and 
Activities lists, your To-Do and Activities lists, or Activities Only.

Who The default is the user that created the Best Action. You can assign 
the action to another employee or person on your sales team.

Start Automatically populated. An action must have a start date to appear 
in the Calendar.

Due Click the Calendar control and choose the completion date for the 
action.

Status Indicate the status for an action by selecting it from the list of values.

Display Indicate where you want the action to appear by selecting from the 
list of values. Options are Calendar and Activities, To-Do and 
Activities, and Activities Only. The default is Calendar and Activities. 
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Adding Position Summary Information
The Position Summary view helps sales professionals identify Red Flags and 
Strengths to use in the opportunity. With this information, you can identify and 
track information needed to improve your competitive position.

To add position summary information

1 Navigate to the Opportunities screen.

2 In the Opportunities list, select the opportunity.

3 Click the Strategic Selling view tab.

4 From the Show drop-down list, choose Position Summary.

5 In the Position Summary form, complete the Strengths and Red Flag fields.

Strengths and Red Flags help you determine your strengths and weaknesses for 
closing this opportunity.

6 In the Information Needed form, click New.

7 In the new record, identify what information is needed, and designate a source 
for the information in the What and From Whom fields.

NOTE: Records in the Information Needed list also appear in the Activities list for 
the opportunity. The Activity Type is Information Needed.
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Creating a Blue Sheet Report
The Blue Sheet uncovers and communicates key information at a glance. It helps to 
focus your team’s attention on essential business and contact information. You can 
print the Blue Sheet or email it to your manager and team in report format or as an 
HTML document.

To create a Blue Sheet report

1 Navigate to the Opportunities screen.

2 In the Opportunities list, select the opportunity.

3 Click the Strategic Selling view tab.

4 From the application-level menu choose View > Reports.

5 In the Reports dialog box, select the Blue Sheet report, the language and locale.

6 Click Run Now.

Click Schedule to run the report at a later date and time.
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Most Commonly Used Views
Table 8 lists view that are commonly associated with Siebel application screens.

Table 8. Common Siebel Application Views

View Description

Activities View and associate activities with a record.

Activity Plans Associate activity plans with a record. An activity plan template is a 
set of activities directed toward a specific business goal or marketing 
technique.

Agreements Associate agreements with the selected record.

Attachments Attach files created in other programs to the selected record.

Calendar Add appointments, meetings, and other relevant events to the selected 
record by entering them in the Calendar view tab.

Categories Associate categories with accounts, opportunities, products, and 
contacts.

Change Requests Create any change requests associated with the selected record.

Contacts Associate contacts with the selected record.

Charts View charts associated with the selected record.

Explorer View information in a hierarchical format, similar to that of Windows 
Explorer. 

Literature View brochures, white papers, and other items associated with the 
selected record.

Messages Associate phone messages with the selected record.

More Info View detailed information about the selected record.
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Notes Associate text notes with the selected record. Notes can be shared 
among others, or they can be designated private.

Opportunities Associate new or existing opportunities with the selected record.

Orders Add orders to the selected record.

Organizations View organizations related to the selected record. 

Products Associate products with the selected record.

Profile View a collection of important information about the selected record.

Quotes Add quotes to the selected record. 

Table 8. Common Siebel Application Views

View Description
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